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Prefață 

 

Datorită contextului contemporan al dinamicii proiectării, dezvoltării, producerii 

și investigării motoarelor cu ardere internă lucrarea de față a apărut ca și o necesitate 

imediată în abordarea celor amintite, prin metode moderne de modelare și simulare 

efectuate prin procese de analiză numerică computerizată. 

Avantajele oferite de metodele și metodologiile moderne de modelare și simulare 

numerică față de metodele tradiționale de proiectare, dezvoltare și investigare a 

proceselor funcționale ale unui motor cu ardere internă sunt reflectate în primul rând 

prin economia de resurse (timp, resurse umane și materiale), posibilitatea de a efectua 

un număr mare de experimente virtuale, modificarea unor parametrii, acces imediat la 

datele obținute prin simulare și analiza acestora prin metode avansate de statistică 

matematică. 

Lucrarea se adresează în primul rând către studenții ce frecventează cursurile 

universitare din domeniul ingineriei autovehiculelor dar își propune de asemenea, să 

realizeze transferul de cunoştinţe și experiența acumulată de către autori, către toți 

aceia care au interese legate de domeniul motoarelor cu ardere interne și a 

autovehiculelor. În acest scop s-a realizat o structură a conținutului care să favorizeze 

o parcurgere facilă a pașilor necesari în crearea de competențe și abilități față de 

utilizarea unor instrumente moderne de analiză numerică computerizată. 

Sunt prezentate modalitățile de modelare și simulare a motoarelor cu aprindere 

prin scânteie (MAS) și a motoarelor cu aprindere prin comprimare (MAC), a 

posibilităților de integrare în model și modelare a echipamentelor de comandă și 

control (ECU), a motoarelor mono și poli cilindrice precum și utilizarea și analiza 

datelor obținute prin simulare utilizând unelte de post-procesare. 

Lucrările de laborator sunt dezvoltate pe baza principiului “de la simplu la 

complex”, prin structurarea lor sub forma unui algoritm facil de urmat și explicat 

suficient pentru ca operațiile efectuate să fie înțelese (prin prisma efectului și a 

necesităților lor). 
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Existența unui capitol separat de teste de autoevaluare are ca și scop 

aprofundarea și fixarea cunoștințelor dobândite prin parcurgerea lucrărilor de laborator 

propuse. 

Autorii consideră că această lucrare reprezintă doar un început în domeniul 

analizei numerice a motoarelor cu ardere internă, cu scopul declarant de a fi un 

instrument de diseminare către cei interesați de problematica contemporană a 

dezvoltării potențialului motoarelor cu ardere internă prin metode de analiză numerică 

computerizată. 

 
Cluj-Napoca, 2016 
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Laborator 1: 

Principiile modelării și simulării siste-

melor de management ale motoarelor cu 

ardere internă. Prezentarea generală a 

programului AVL BOOST. 

 

Scop 

 Familiarizarea utilizatorilor cu mediul și programul de modelare și simulare AVL 

BOOST. 

 

Obiective educaționale și de formare a competențelor specifice 

 Identificarea funcțiunilor programului AVL BOOST, a ariilor și a barelor de lucru 

(Toolbar); 

 Utilizarea adecvată a interfeței programului AVL BOOST (GUI – Graphical User 

Interface); 

 Identificarea și funcționalitatea elementelor constructive ale unui model; 

 Utilizarea elementelor constructive pentru cazul particular al unui model de motor 

dat (ales). 

 

Prezentarea lucrărilor de laborator 

Ca și reguli generale privind modul și cerințele de desfășurare al activităților practi-

ce de laborator, acestea vor respecta următoarele cerințe: 

 Activitățile de laborator se vor desfășura conform orarului, în sala prevăzută (aloca-

tă) acestor activități; 

 Se vor stabili echipe de lucru de 2 (max. 3 studenți); 

 Se va aloca un post de lucru (calculator) care va rămâne același pe toată perioada 

de desfășurare a activității de laborator. 
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Activitățile de la fiecare laborator se vor salva în folderul creat inițial pentru aceste 

activități (denumit “Grupa_AAAA_lab_MMAT”), sub denumirea “Echipa_x” (unde x va 

fi numărul alocat echipei de lucru), sau “Nume_prenume” al studentului. 

De asemenea, ținând cont de specificul activităților de laborator, studenții sunt 

obligați: 

 Să respecte normele și regulile interne de desfășurare a lucrărilor practice din ca-

drul Laboratorului de motoare; 

 Să fie instruiți înainte de a efectua un test de încercare pe stand și de a refuza să 

efectueze testul, dacă consideră că testul nu este efectuat în condiții de siguran-

ță; 

 Orice abatere de la normele de siguranță și securitate a muncii va fi adusă imediat 

la cunoștința cadrului didactic și/sau a tehnicianului de serviciu; 

 Să anunțe imediat conducerea departamentului și/sau la numărul de telefon alocat 

serviciilor de urgență – 112, incidentele de siguranță și securitate a muncii. 

  

În cadrul laboratorului 1, activitățile ce urmează a fi desfășurate au ca și scop fa-

miliarizarea utilizatorilor (studenților) cu noțiunile și cerințele caracteristice utilizării simu-

lării computerizate în domeniul motoarelor cu ardere internă. Prin parcurgerea activități-

lor alocate laboratorului 1, se vor prezenta generalitățile, funcțiunile și utilitatea pachetu-

lui de programe AVL BOOST (ce va fi utilizat pe parcursul desfășurării laboratoarelor ce 

urmează). 

Se vor prezenta elementele principale (tip, funcțiune, caracteristici de bază etc.) de 

construcție a unui model ce simulează funcționarea unui motor cu ardere internă, și de 

asemenea, se vor efectua primii pași în crearea unui model (inserarea elementelor în 

zona de lucru, în funcție de specificul motorului ales pentru aplicarea practică a cunoștin-

țelor acumulate). 

 

Prezentarea generală a programului AVL BOOST 

Programul AVL BOOST este o suită de instrumente software de simulare utilizate 

pentru proiectarea și investigarea numerică a unei mari varietăți de modele de motoare, 

în doi sau în patru timpi, cu aprindere prin scânteie sau cu aprindere prin comprimare. 

Cu ajutorul acestei aplicații software se pot genera, dezvolta şi studia modele de 

motoare de la capacități cilindrice mici (cum ar fi motoarele de motocicletă) până̆ la ca-

pacități cilindrice foarte mari (motoare pentru navele maritime). 

Instrumentul software AVL BOOST de analiză a proceselor funcționale ale motoa-

relor cu ardere internă constă dintr-un program de preprocesare, folosit pentru introduce-
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rea datelor inițiale, a datelor de intrare şi a caracteristicilor tehnice a motorului care ur-

mează̆ a fi construit ca și model. 

După asamblarea efectivă a elementelor care alcătuiesc motorul împreună cu sis-

temele anexe, ecuațiile matematice și algoritmii de calcul ai modelului care stau în spate-

le interfeței grafice cu utilizatorul, vor analiza și calcula procesele care sunt cerute în 

timpul simulărilor. 

O particularitate a programului AVL BOOST este aceea că mișcarea fluidelor prin 

conducte este tratată ca fiind “0” dimensională. Acest lucru înseamnă că parametrii fizici 

precum presiunile, temperaturile şi vitezele de curgere din cadrul sistemului studiat, vor fi 

obţinute din soluţiile rezolvării ecuaţiilor de dinamică a gazelor și reprezintă valorile medii 

pe secțiunea transversală a conductelor (ipoteză simplificatoare). 

Pornirea mediului de simulare AVL BOOST se poate realiza în două moduri: 

1. Prin accesul barei de comanda a sistemului de operare și click pe icon-ul AVL 

AST (figura 1.1); 

2. Prin dublu click pe icon-ul AVL AST de pe desktop și click pe butonul AVL BO-

OST (figura 1.2). 

Ca și aplicație practică, se va alege mediul de simulare AVL BOOST și se așteap-

tă încărcarea programului. Prin lansarea (deschiderea) programului, va apare următorul 

ecran (figura 1.3). Meniul și bara de unelte a programului de simulare AVL BOOST sunt 

prezentate în figura 1.4. 

Pentru salvarea unui model creat în aplicația AVL BOOST se vor parcurge pașii 

următori: 

 Modelul computerizat creat va fi salvat prin accesarea meniului: File->Save As. 

 Modelul va fi salvat sub forma “Nume_Prenume.bwf”. Salvarea se va realiza în 

folderul (directorul) ce este repartizat utilizatorului/studentului respectiv. 

 Pentru încărcarea modelului la o ședință nouă de laborator, se va accesa din nou 

meniul prin opțiunile File -> Open, și se va alege denumirea fișierului salvat ante-

rior. 

Foaia de lucru încărcată în aplicația AVL BOOST se dimensionează în funcție de 

mărimea modelului care va fi dezvoltat și/sau de numărul de elemente componente ale 

modelului.  

Dimensionarea foii de lucru se realizează din comanda File -> Page Setup: de 

unde se alege orientarea paginii (Portrait sau Landscape) și dimensiunea paginii (după 

un standard A4 sau A3, respective la dimensiuni definite de utilizator). 
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Fig. 1.1 Lansare (deschidere) program din bara de comanda a sistemului de operare 

 

 

Fig. 1.2 Lansare (deschidere) program din icon-ul de pe ecran 
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Fig. 1.3 Ecranul principal de lansare a programului de simulare AVL BOOST 

 

 

Fig. 1.4 Meniul si bara de unelte a programului de simulare AVL BOOST 

 

Alegerea elementelor ce compun un model, se realizează din bara de unelte aflată 

în partea stângă a ecranului principal (selectare simplă prin intermediul mouse-ului). Po-

ziționarea elementului în cadrul ariei de lucru se realizează simplu, cu ajutorul mouse-lui, 

prin dublu click (figura 1.5). 

 

Identificarea elementele constructive ale unui model. Generalități. 

Elementele (sau blocurile) ce definesc funcționarea componentelor și/sau sisteme-

le și echipamentele unui motor cu ardere internă, oferă posibilitatea de a modela un mo-

tor cu ardere internă de la modele simple până la modele complexe. 

Caracteristica de complexitate a acestor modele este dată în primul rând de tipul motoru-

lui ce urmează a fi simulat (tipul de aprindere, număr de cilindrii, sisteme auxiliare de su-

praalimentare, consumatori mecanici conectați etc.). 
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Fig. 1.5 Ecranul de lucru al aplicației AVL BOOST 

(poziționarea ariei de construire / lucru a modelelor) 

 

În continuare se va prezenta modalitatea de identificare a elementelor (a blocurilor) 

funcționale, ce vor fi utilizate în modelarea unui motor cu ardere internă, în mediul de 

simulare AVL BOOST. 

 

Elemente generale (înglobează mai multe sub-modele funcționale) (figura 1.6): 

 C1 – Cilindru 

 E1 – Motor 

 MCH1 - Consumator mecanic 

 V1 – Vehicul 

 RP1 - Piston rotativ 

 MP1 - Punct de măsură  

 D1 - Element necunoscut 

 ATP1 - Conexiune post-tratament 

 

 
 
 
 
 

Elemente utilizate în con-
strucția modelului în AVL 

BOOST 

Suprafața utilă 
de lucru 
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Fig. 1.6 Icon-urile alocate elementelor generale 

 

Elemente de definire a limitelor modelului (figura 1.7): 

 SB1 - Limită de sistem (admisie sau evacuare în cazul motoarelor) 

 ATB1 - Limită post-tratament 

 IB1 - Limită internă 

 

 

Fig. 1.7 Icon-urile alocate elementelor de definire a limitelor modelului 

 

Elemente de transfer (figura 1.8): 

 R1 - Restricție 

 TH1 - Accelerație 

 RV1 - Valvă/Supapă rotativă 

 CV1 - Supapă de siguranță 

 I1 – Injector 

 ATI1 - Injector post-tratament 

 J1 - Joncțiune 
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Fig. 1.8 Icon-urile alocate elementelor de transfer 

 

Elemente de definire a volumelor (figura 1.9): 

 PL1 - Plenum (volum) 

 3DG1 - Element 3D general 

 3DS1 - Element 3D sferic 

 VP1 - Plenum variabil 

 PPiP1 - Conductă în conductă 

 CL1 - Filtru de aer 

 CAT1 – Catalizator 

 CO1 – Radiator 

 DPF1 - Filtru de particule diesel 

 

  

Fig. 1.9 Icon-urile alocate elementelor de definire a volumelor 

 

Elemente de încărcare a motorului (figura 1.10): 

 TC1 - Turbosuflantă 

 T1 - Turbină 

 TCP1 – Turbocompresor 

 PDC1 - Compresor cu debit pozitiv 

 WG1 - Valvă de presiune 

 PWSC1 - Element BOOST (Flow Sim) 

 ED1 - Dispozitiv electric 
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Fig. 1.10 Icon-urile alocate elementelor de încărcare a motorului 

 

Elemente de legătură externe cu alte programe de simulare AVL AST (figura 1.11): 

 L1 - Legătură cu AVL FIRE 

 UDE1 - Element definit de utilizator 

 CFD1 - Legătură cu CFD 

 CRL1 - Legătură cu AVL CRUISE 

 

 

Fig. 1.11 Icon-urile alocate elementelor de legătură cu alte programe de 

simulare externe mediului AVL BOOST 

 

Elemente de comandă și control ale motorului (figura 1.12): 

 ECU1 - Unitate electronică de control 

 DLL1 - Element control MATLAB 

 EI1 - Interfață cu motorul 

 PID1 - Controler PID 

 FI1 - Interpretor de formule 

 MNT1 – Monitor 
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Fig. 1.12 Icon-urile alocate elementelor de comanda și control 

 

Elemente de definire a componentelor acustice (figura 1.13): 

 MIC1 – Microfon 

 PER1 - Suprafață perforată 

 OGC1 - Element acustic 

 OP1 - Țevi suprapuse 

 FBR1 - Element acustic 

 

 

Fig. 1.13 Icon-urile alocate elementelor de tip acustic 

 

 

Aplicație practică: identificarea și amplasarea elementelor și blocurilor funcționale 

principale în zona de lucru. 

 

Pentru realizarea aplicației practice din cadrul laboratorului se vor poziționa în ca-

drul ecranului (ariei) de lucru, elementele și blocurile funcționale principale ale unui mo-

tor cu ardere internă. 

Elementele constructive sunt caracteristice unui model de motor cu aprindere prin 

comprimare (diesel), în 6 cilindrii în linie, cu sistem de supraalimentare (Turbocharger).  
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Blocurile funcționale necesare construirii modelului sunt următoarele (figura 

1.14): 

 6 elemente Cylinders (C) 

 1 element Intercooler – (CO) 

 1 element Turbocharger – (TC) 

 1 element Engine – (E) 

 2 elemente System Boundaries – (SB) 

 3 elemente Plenum – (PL) 

 8 elemente Pipes Number – (P) 

 8 elemente Measuring Points – (MP) 

 

Fiecare element se selectează inițial din bara elementelor (partea stângă a ecranu-

lui) și se adaugă̆ cu un dublu- click pe icon-ul elementului ales, în interiorul ariei de lucru. 

Poziționarea/mutarea acestora în cadrul ariei de lucru, se realizează prin selecta-

rea elementului (blocului) funcțional (click stânga mouse), tragerea și amplasarea la locul 

dorit/prestabilit (butonul stânga al mouse-ului se menține apăsat). 

 

 

Fig. 1.14 Exemplu de amplasare a blocurilor (elementelor)  

funcționale în aria de lucru 
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Laborator 2: 

Modelarea și simularea unui motor 

monocilindric cu aprindere prin scân-

teie. Setări generale. 

 

Scop 

 Crearea, parametrizarea și simularea unui model de motor cu aprindere prin 

scânteie monocilindric. 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a unor metode moderne de investigare a pro-

ceselor funcționale ale motoarelor cu ardere internă; 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată. 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în modelarea unui motor cu aprindere prin scânteie monocilindric. Se 

prezintă detaliat modul de realizare a modelului general precum și a setărilor genera-

le a modelului de motor supus simulării, în mediul de simulare AVL BOOST. 

 

Desfășurarea lucrării 

 Lucrarea de laborator nr. 2 se desfășoară prin parcurgerea algoritmului prezen-

tat în cele ce urmează, în scopul realizării unei aplicații practice de modelare a unui 

motor monocilindric cu aprindere prin scânteie. 

 Modelul se construiește prin plasarea elementelor componente în interiorul zo-

nei de lucru și interconectarea lor prin intermediul elementelor de conectare - Pipes. 
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Nu este necesară o ordine prestabilită de amplasare a elementelor sau a pozi-

ționării lor exacte în interiorul zonei de lucru. 

Alegerea unui element component și amplasarea lui se realizează prin efectua-

rea cu ajutorul mouse-ului (dublu click pe element în zona de identificare a elemente-

lor - Element Tree). Pentru poziționarea în cadrul zonei de lucru (de creare a mode-

lului) se selectează elementul (simplu click), se menține apăsat butonul stâng al mo-

use-ului și se mută elementul acolo unde se dorește (figura 2.1). 

 

 

Fig. 2.1 Inserarea unui element în zona de lucru 

 

Particular, în cazul ce urmează a fi prezentat, modelul de motor ales a fi mode-

lat și simulat se compune din următoarele elemente componente (figura 2.2): 

 1 buc. motor (Engine) 

 1 buc. cilindru motor (Cylinder) 

 1 buc. filtru de aer (Air Cleaner) 

 1 buc. catalizator (Catalyst) 

 1 buc. injector (Injector) 

 2 buc. elemente intrare/ieșire – admisie/evacuare (System Boundaries)  

 3 buc. volume de compensare (Plenum) 

 3 buc. restricții (Restrictions) 

 10 buc. puncte de măsurare și monitorizare (Measuring Points) 

 12 buc. conexiuni (Pipes) 
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Fig. 2.2 Elementele modelului de motor cu aprindere prin scânteie în AVL BOOST 

 

Conexiunea dintre elemente (figura 2.3) se realizează prin selectarea opțiunii 

Connection din bara de unelte, iar prin conexiune se atașează elementelor conecta-

te (se selectează capetele conexiunii și se conectează cu elementele specifice, unind 

ancorele elementelor). 

 

 
Fig. 2.3 Conectarea elementelor 
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Conexiunile mecanice (portocaliu) și conductele de curgere pentru fluide (ne-

gru), trebuie definite corespunzător caracteristicilor lor, iar conexiunile electrice (al-

bastru) sunt considerate a fi conectori de legătură care nu se definesc (figura 2.4). 

 

   
a) b) c) 

Fig. 2.4 Conectarea elementelor constructive: 

a – conexiune pentru fluide (negru), b – mecanică (orange), c – electrică (albastru). 

 

Pentru schimbarea direcției de conectare se folosește comanda Change Di-

rection din bara de meniu, iar pentru schimbarea legăturilor efectuate între elemente 

se folosește comanda Change Connection. 

Modelul creat prin efectuarea operațiilor anterior prezentate va avea forma ce-

lui prezentat în figura 2.5. 

 

 
Fig. 2.5 Model de motor cu aprindere prin scânteie monocilindric în AVL BOOST 
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Introducerea datelor generale privind modelul 

Înainte de a defini și parametriza fiecare element în funcție de specificul lui, 

prin utilizarea programului de modelare și simulare AVL BOOST este obligatoriu să 

fie introduse datele generale privind modelul și condițiile generale de simulare. 

Definirea și introducerea datelor generale (globale) se realizează prin accesa-

rea din meniu a opțiunii Simulation -> Control, ceea ce va duce la deschiderea ur-

mătoarei ferestre de lucru. 

 

Pas 1. Opțiunea SIMULATION TASKS 

Click pe Simulation -> Tasks și selectați Cycle Simulation. 

 

Pas 2. Opțiunea CYCLE SIMULATION 

Click pe subgrupul Cycle Simulation ceea ce va duce la deschiderea urmă-

toarei ferestre de lucru (figura 2.6): 

 

 
Fig. 2.6 Opțiunea CYCLE SIMULATION 

 

Inserați următoarele date: 

Species Transport     Classic (default)  

Simulation Interval 

End of Simulation     10 cycles (7200 deg) 

Spatial Pipe Discretization 

Average Cell Size     25 mm 
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Pas 3. Opțiunea CLASSIC SPECIES SETUP 

Click pe Classic Species -> Setup ceea ce va duce la deschiderea următoarei 

ferestre de lucru (se vor păstra valorile afișate în figura 2.7): 

 

 
Fig. 2.7 Opțiunea CLASSIC SPECIES SETUP 

 

Pas 4. Opțiunea INITIALIZATION 

Click pe Initialization pentru deschiderea ferestrei “Initialization”. Selectați 

A/F-Ratio din meniul Ratio. Selectați Add Set și introduceți datele din figura 2.8 și 

tabelul 2.1. 

 

 
Fig. 2.8 Condițiile de inițializare 
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Tabel 2.1 Condițiile de inițializare 

Set Pressure 

(bar) 

Temperature 

(degC) 

Fuel Va-

pour (-) 

Combustion 

Products (-) 

A/F Ratio 

(-) 

1 0.969 20 0.000 0.000 10000 

2 0.979 25 0.075 0.000 10000 

3 1.105 800 0.000 1.000 13.54 

4 1.055 600 0.000 1.000 13.54 

 

Pas 5. Opțiunea RESTART CONTROL 

Click pe Restart Control pentru deschiderea ferestrei de lucru. Selectați Spe-

cific Interval din meniul Restart File Saving Interval și introduceți valoarea de mai 

jos pentru Saving Interval (figura 2.9). 

 

Restart Simulation     No 

Use Most Recent Restart File   Selected 

Restart File 

Restart File Saving Interval   Specific Interval 

Saving Interval       720 deg 

 

 
Fig. 2.9 Opțiunea RESTART CONTROL 
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Pas 6. Opțiunea OUTPUT CONTROL 

Click pe Output Control și introduceți valoarea de mai jos pentru Saving In-

terval (figura 2.10). Click OK. 

 

Traces 

Saving Interval      3 deg 

Reference Ambient Conditions 

Pressure       1 bar 

Temperature      25 degC 

 

 
Fig. 2.10 Opțiunea OUTPUT CONTROL 

 

La sfârșitul sesiunii de lucru, toate operațiile efectuate conform cu algoritmul de 

lucru al laboratorului se salvează folosind comanda din meniul programului Save As 

/ Save. 
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Laborator 3: 

Modelarea și simularea unui motor 

monocilindric cu aprindere prin scân-

teie. Parametrizarea motorului. 

 

Scop 

 Crearea, parametrizarea și simularea unui model de motor cu aprindere prin 

scânteie monocilindric 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a unor metode moderne de investigare a pro-

ceselor funcționale ale motoarelor cu ardere internă 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în parametrizarea elementelor unui motor cu aprindere prin scânteie 

monocilindric. Se prezintă detaliat modul de parametrizare a elementului motor su-

pus simulării. 

 

Desfășurarea lucrării 

Lucrarea de laborator nr. 3 se desfășoară prin parcurgerea algoritmului prezen-

tat în cele ce urmează, în scopul continuării lucrărilor deja efectuate în cadrul labora-

toarelor anterioare, în scopul realizării unei aplicații practice de modelare a unui mo-

tor monocilindric cu aprindere prin scânteie. 

Pentru parametrizarea (introducerea datelor specifice) fiecărui element al mo-
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delului se va proceda în felul următor. 

În modelul general creat în zona de lucru, selectați elementul dorit a fi definit, 

printr-un click cu butonul stânga al mouse-ului și după aceasta operație deschideți o 

fereastră de dialog prin acționarea butonului dreapta al mouse-ului. Selectați Proper-

ties din fereastra de dialog și se va deschide o fereastră de lucru în care pot fi inse-

rate datele specifice elementului selectat. 

Este importantă mențiunea că datele ce caracterizează un element pot fi copia-

te și transmise unui alt element omolog prin operația Element -> Copy Data. 

 

ENGINE 

Pas 1. Opțiunea GENERAL 

Click pe Engine pentru deschiderea ferestrei de lucru (figura 3.1). Introduceți 

valoarea de (4000 rpm) pentru Engine Speed. 

 

 
Fig. 3.1 Opțiunea GENERAL 

 

Pas 2. Opțiunea ENGINE FRICTION 

În subgrupul Engine Friction, opțiunea Table este selectată ca și opțiune ge-

nerală. Click pe Engine Friction[1]: friction_list pentru deschiderea ferestrei de lu-

cru. Introduceți următoarele valori (figura 3.2): 

BMEP       10 bar 

Col. (X) Engine Speed (rpm)   Col. (Y) FMEP (bar) 

1000        0.7 

4000        2.0 
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Fig. 3.2 Opțiunea ENGINE FRICTION 

 

CYLINDER 

Pas 1. Opțiunea GENERAL 

Click pe Cylinder pentru deschiderea ferestrei de lucru (figura 3.3). 

 

 
Fig. 3.3 Opțiunea GENERAL 
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Introduceți următoarele valori: 

Bore        84 mm 

Stroke       90 mm 

Compression Ratio     9 

Piston Pin Offset     0 mm 

Effective Blow by Gap    0 mm 

Mean Crankcase Press    1 bar 

Scavenge Model     Perfect Mixing 

 

Pas 2. Opțiunea INITIALIZATION 

Click pe subgrupul Initialization pentru deschiderea ferestrei de lucru (figura 

3.4). 

 

 
Fig. 3.4 Opțiunea INITIALIZATION 

 

Introduceți următoarele valori: 

Initial Conditions at EO  

(Exhaust Valve Opening) 

Pressure       4 bar 

Temperature      900 degC 

Initial Gas Composition   

Ratio Type       A/F Ratio 

Ratio Value      13.54 

Fuel Vapour      0 

Combustion Products    1 
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Pas 3. Opțiunea COMBUSTION 

Click pe subgrupul Combustion și selectați opțiunea Vibe (modelul de ardere) 

pentru modul de caracterizare a căldurii rezultate în urma procesului de ardere (Heat 

Release) (figura 3.5).  

 

 
Fig. 3.5 Opțiunea COMBUSTION 

 

Click pe subgrupul Vibe pentru deschiderea ferestrei de lucru și introduceți ur-

mătoarele valori (figura 3.6): 

Start of Combustion     700 deg 

Combustion Duration    50 deg 

Shape Parameter 

Parameter “m”      2 

Parameter “a”      6.9 
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Fig. 3.6 Modelul de ardere VIBE 

 

Pas 4. Opțiunea HEAT TRANSFER 

Click pe subgrupul Heat Transfer și introduceți următoarele valori (figura 3.7): 

Cylinder       Woschni 1978 

Ports       Zapf 

Piston      

Surface Area      
2

2

5500
4

mm
D

S piston 





 

Wall Temperature     CspeedTpiston deg380045.0200   

Piston Calibration Factor    1 

Cylinder Head 

Surface Area      
2

2

7150
4

3.1 mm
D

Scilindru 





 

Wall Temperature   CspeedTcilindru deg34040045.0200   

Head Calibration Factor    1 

Liner 

Surface Area      
2

2

960
4

mml
D

S pistonsegment 





 

Wall Temperature TDC  CspeedT PMSsegment deg30080045.0200_   
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Wall Temperature BDC  CspeedT PMIsegment deg220160045.0200_   

Liner Calibration Factor    1 

Combustion System     DI (Direct Injection) 

In-cylinder Swirl Ratio    1 

 

 
Fig. 3.7 Opțiunea HEAT TRANSFER 

 

Pas 5. Opțiunea VALVE PORT SPECIFICATIONS 

Click pe subgrupul Valve Port Specification și introduceți datele din figura 3.8: 

 

 
Fig. 3.8 Opțiunea VALVE PORT SPECIFICATIONS 
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Pipe  Control  Surface Area (mm2)  Wall Temperature (degC) 

5  Valve    15800    120 

6  Valve      5840    300 

 

Click pe subgrupul VPS [1]: Pipe 5: Intake -> Valve Controlled pentru acce-

sarea câmpurilor de introducere a datelor (figura 3.9): 

 

 
Fig. 3.9 Subgrupul Intake -> Valve Controlled 

 

Inner Valve Seat  

(=Reference) Diameter    40 mm 

Valve Clearance      0.2 mm 

Scaling Factor  

for Eff. Flow Area  256.1
444

22

2

22

 ivi

i

ivi
sceff

dvndp

dp

dvndp
fA








  

unde α este coeficientul de curgere (Flow Coefficent) [-], dpi – diametrul con-

ductei considerate [m], nv este numărul de supape pentru portul considerat [-], dvi – 

diametrul scaunului interior al supapei (Inner Valve Seat Diameter) [m]. 

Click pe Lift Curve pentru deschiderea ferestrei de lucru și introduceți urmă-

toarele date: 

Specification:       Manipulation: 

Valve Opening:   292 deg   Valve Opening:  292 deg 

Cam Length:   368 deg   Cam Length:  368 deg 

Increment:   8 deg 
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Datele necesare parametrizării procesului de admisie (definite pentru elementul 

Pipe 5 a diagramei distribuției la admisie Crank Angle și Valve Lift) sunt cele pre-

zentate în tabelul 3.1 și în figura 3.10, iar aceste date trebuie introduce în câmpurile 

respective. 

 

Tabelul 3.1 Valorile Intake Lift Curve 

Crank Angle X 

(deg) 

Valve Lift Y  

(mm) 

Crank Angle X 

(deg) 

Valve Lift Y  

(mm) 

292 0 484 9.90 

300 0.06 492 9.70 

308 0.12 500 9.37 

316 0.18 508 8.92 

324 0.24 516 8.40 

332 0.30 524 7.71 

340 0.36 532 6.95 

348 0.44 540 6.10 

356 0.65 548 5.15 

364 1.04 556 4.11 

372 1.69 564 3.07 

380 2.57 572 2.11 

388 3.60 580 1.33 

396 4.63 588 0.80 

404 5.61 596 0.52 

412 6.53 604 0.42 

420 7.34 612 0.33 

428 8.05 620 0.27 

436 8.66 628 0.20 

444 9.16 636 0.15 

452 9.60 644 0.10 

460 9.80 652 0.03 

468 9.96 660 0.00 

476 9.99 - - 
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Fig. 3.10 Subgrupul Intake -> Intake Lift Curve 

 

Click on Flow Coefficient pentru deschiderea ferestrei de lucru și introduceți 

următoarele valori (tabelul 3.2 și figura 3.11): 

 

Tabelul 3.2 Valorile Flow Coefficient 

Valve Lift X  
(mm) 

Flow Coefficient Y  
(-) 

0 0.000 

1 0.070 

2 0.145 

3 0.220 

4 0.300 

5 0.355 

6 0.405 

7 0.455 

8 0.480 

9 0.500 

10 0.520 

11 0.535 

12 0.540 

13 0.545 

14 0.550 

  

Pressure Ratio      1 

Effective Valve Lift     Activated 
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Fig. 3.11 Subgrupul Intake -> Flow Coefficient 

 

Click pe subgrupul VPS [2]: Pipe 6 Exhaust -> Valve Controlled pentru acce-

sarea câmpurilor de introducere a datelor (figura 3.12): 

 

 
Fig. 3.12 Subgrupul Exhaust -> Valve Controlled 

 

Inner Valve Seat  

(=Reference) Diameter    35 mm 

Valve Clearance      0.3 mm 

Scaling Factor  

for Eff. Flow Area     962.0
4

2

 iv
eff

dvn
A


  
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unde α este coeficientul de curgere (Flow Coefficent) [-], dpi – diametrul con-

ductei considerate [m], nv este numărul de supape pentru portul considerat [-], dvi – 

diametrul scaunului interior al supapei (Inner Valve Seat Diameter) [m]. 

Click pe Lift Curve pentru deschiderea ferestrei de lucru și introduceți urmă-

toarele date: 

Specification       Manipulation 

Valve Opening   66 deg   Valve Opening  66 deg 

Cam Length   368 deg   Cam Length  368 deg 

Increment    8 deg 

 

Datele necesare parametrizării procesului de admisie (definite pentru elementul 

Pipe 6 a diagramei distribuției la evacuare – Crank Angle și Valve Lift) sunt cele 

prezentate în tabelul 3.3 și în figura 3.13. Aceste date trebuie introduse în câmpurile 

respective. 

 

Tabelul 3.3 Valorile Exhaust Lift Curve 

Crank Angle X 
(deg) 

Valve Lift Y  
(mm) 

Crank Angle X 
(deg) 

Valve Lift Y  
(mm) 

66 0 258 9.90 

74 0.06 266 9.70 

82 0.12 274 9.37 

90 0.18 282 8.92 

98 0.25 290 8.40 

106 0.32 298 7.70 

114 0.36 306 6.95 

122 0.45 314 6.08 

130 0.65 322 5.14 

138 1.10 330 4.12 

146 1.70 338 3.07 

154 2.57 346 2.10 

162 3.60 354 1.33 

170 4.63 362 0.82 

178 5.60 370 0.52 

186 6.53 378 0.40 

194 7.34 386 0.33 

202 8.05 394 0.27 

210 8.66 402 0.21 

218 9.16 410 0.15 

226 9.55 418 0.09 

234 9.80 426 0.03 

242 9.96 434 0.00 

250 9.98 - - 
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Fig. 3.13 Subgrupul Exhaust -> Intake Lift Curve 

  

Click on Flow Coefficient pentru deschiderea ferestrei de lucru și introduceți 

următoarele valori (tabelul 3.4 și figura 3.14): 

 

Tabelul 3.4 Valorile Flow Coefficient 

Valve Lift X  
(mm) 

Flow Coefficient Y  
(-) 

0 0.000 

1 0.010 

2 0.180 

3 0.260 

4 0.340 

5 0.410 

6 0.460 

7 0.500 

8 0.530 

9 0.540 

10 0.550 

11 0.560 

12 0.560 

13 0.560 

14 0.560 

  

Pressure Ratio:    1 

Effective Valve Lift:   Activated 
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Fig. 3.14 Subgrupul Exhaust -> Flow Coefficient 

 

La sfârșitul sesiunii de lucru, toate operațiile efectuate conform cu algoritmul de 

lucru al laboratorului se salvează folosind comanda din meniul programului Save As 

/ Save. 
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Laborator 4: 

Modelarea și simularea unui motor 

monocilindric cu aprindere prin scân-

teie. Parametrizarea elementelor auxi-

liare. 

 

Scop 

 Crearea, parametrizarea și simularea unui model de motor cu aprindere prin 

scânteie monocilindric 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a unor metode moderne de investigare a pro-

ceselor funcționale ale motoarelor cu ardere internă 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în parametrizarea elementelor auxiliare ale unui motor cu aprindere 

prin scânteie monocilindric. Se prezintă detaliat modul parametrizare a fiecărui ele-

ment auxiliar aflat în componența al modelului general. 

De asemenea se prezintă modalitatea de efectuare a simulării propriu-zise a 

modelul de motor ce este finalizat în cadrul acestui laborator. 

 

Desfășurarea lucrării 

Lucrarea de laborator nr. 4 se desfășoară prin parcurgerea algoritmului prezen-

tat în cele ce urmează. Parametrizarea elementelor auxiliare se realizează în con-
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formitate cu cele ce urmează a fi prezentate. Procesul de rulare a simulării compute-

rizate este de asemenea prezentat în cadrul acestui laborator. 

 

AIR CLEANER 

Accesul la câmpurile necesare parametrizării elementului filtru de aer (Air 

Cleaner) din cadrul modelului general se efectuează prin efectuarea unui click pe 

element. Se accesează opțiunile din meniu și se introduc datele prezentate. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți valorile (figura 4.1 și figura 4.2): 

 

 
Fig. 4.1 Opțiunea GENERAL 

 

 
Fig. 4.2 Opțiunea FRICTION 
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Geometrical Properties 

Total Air Cleaner Volume    3.1 l 

Inlet Collector Volume    1.8 l 

Outlet Collector Volume    1.2 l 

Length of Filter Element    65 mm 

Friction Specification     Target Pressure Drop 

Target Pressure Drop  

Mass Flow       0.02 kg/s 

Target Pressure Drop    0.02 bar 

Inlet Pressure      0.98 bar 

Inlet Air Temperature     25 degC 

 

Pas 2. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients introduceți valorile (figura 4.3): 

 

 
Fig. 4.3 Opțiunea FLOW COEFFICIENTS 

 

Pipe 1 Inflow     0.95 

  Outflow     0.95 

Pipe 2  Inflow     0.95 

  Outflow     0.95 

 

CATALYST 

Accesul la câmpurile necesare parametrizării elementului catalizator (Catalyst) 

din cadrul modelului general se efectuează prin efectuarea unui click pe element. Se 

accesează opțiunile din meniu și se introduc datele prezentate în cele ce urmează. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 4.4): 
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Fig. 4.4 Opțiunea GENERAL 

 

Chemical Reactions     none 

Monolith Volume     0.3 l 

Length of Monolith     115 mm 

Inlet Collector Volume    0.1 l 

Outlet Collector Volume    0.1 l 

 

Pas 2. Opțiunea TYPE SPECIFICATION 

Click pe subgrupul Type Specification și introduceți următoarele valori (figura 

4.5): 

 

  
Fig. 4.5 Opțiunea TYPE SPECIFICATION 
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Catalyst Type Specification 

General Catalyst 

Open Frontal Area (OFA)    1 

Hydraulic Unit 

Diameter       58.25 mm 

Geometrical Surface Area    68.669528 

 

Pas 3. Opțiunea FRICTION 

Click pe subgrupul Friction și introduceți următoarele valori (figura 4.6): 

 

  
Fig. 4.6 Opțiunea FRICTION 

 

Friction Specification     Target Pressure Drop 

Target Pressure Drop 

Inlet Massflow      0.024 kg/s 

Inlet Temperature     800 degC 

Inlet Pressure      1.1 bar 

Target Pressure Drop    0.1 bar 

 

Pas 4. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients  și introduceți următoarele valori: 

Pipe 7  Inflow     1 

Pipe 7  Outflow     1 

Pipe 8  Inflow     1 

Pipe 8  Outflow     1 
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INJECTOR 

Accesul la câmpurile necesare parametrizării elementului injector (Injector) din 

cadrul modelului general se efectuează prin efectuarea unui click pe element. 

Se accesează opțiunile din meniu și se introduc datele prezentate în cele ce 

urmează. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 4.7): 

 

Injection Method    Continuous MASS FLOW 

 

Pas 2. Opțiunea MASS FLOW 

Click pe subgrupul Mass Flow și introduceți următoarele valori (figura 4.8): 

Air Fuel Ratio 14 

Injector Model      Injection Nozzle 

Air Flow taken from 

Measuring Point     Measuring Point 1 

The Inject Covers     100 % of the Total Air Flow 

 

  
Fig. 4.7 Opțiunea GENERAL 
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Fig. 4.8 Opțiunea MASS FLOW 

 

Pas 3. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

Injector 1 

from Pipe 3 to Pipe 4     1 

from Pipe 4 to Pipe 3     1 

 

SYSTEM BOUNDARY 

Prin accesarea acestui câmp de parametrizare se vor defini “granițele” modelu-

lui: zona de admisie și zona de evacuare. Accesul la fiecare zonă se realizează 

printr-un click pe elementul din cadrul modelului necesar a fi parametrizat. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General ->Standard -> Boundary Type (figura 4.9). 

 

  
Fig. 4.9 Opțiunea GENERAL 
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Pas 2. Opțiunea BOUNDARY CONDITIONS 

Click pe subgrupul Boundary Conditions și introduceți valorile din tabelul 4.1: 

 

Tabel 4.1 Condițiile de inițializare 

Set Pressure 

(bar) 

Temperature 

(degC) 

Fuel Va-

pour (-) 

Combustion 

Products (-) 

A/F Ratio 

(-) 

SB 1 1 20 0 0 10000 

SB 2 1 120 0 1 14 

 
 

Selectați Local Boundary->Conditons și Set 1 din meniul Preference (figura 

4.10): 

 

  
Fig. 4.10 Opțiunea BOUNDARY CONDITIONS 

 

Pas 3. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

SB 1 

Pipe 1 

Inflow       1.00 

Outflow       1.00 

 

SB 2 

Pipe 11 

Inflow       0.98 

Outflow       0.98 
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PLENUM 

Prin accesarea acestui câmp de parametrizare se vor defini volumele de com-

pensare ale modelului (Plenum). Accesul la fiecare volum se realizează printr-un 

click pe elementul din cadrul modelului, necesar a fi parametrizat. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți valoarea de (1.8 litri) pentru parame-

trul Volume pentru fiecare element Plenum din model (figura 4.11). 

 

 
Fig. 4.11 Opțiunea GENERAL 

 

Pas 2. Opțiunea INITIALIZATION 

Click pe subgrupul Initialization și selectați Global Initialization pentru fiecare 

Plenum din model. Selectați opțiunea Set 1 din meniul Preference (figura 4.12). 

 

  
Fig. 4.12 Opțiunea INITIALIZATION 
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Pas 3. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

 

Plenum 1 

Pipe 8 

Inflow       0.98 

Outflow       0.98 

 

Pipe 9 

Inflow       0.98 

Outflow       0.98 

 

Pipe 12 

Inflow       0.98 

Outflow       0.98 

 

Plenum 2 

Pipe 9 

Inflow       0.98 

Outflow       0.98 

 

Pipe 10 

Inflow       0.98 

Outflow       0.98 

 

Plenum 3 

Pipe 10 

Inflow       0.98 

Outflow       0.98 

 

Pipe 11 

Inflow       0.50 

Outflow       0.50 

 

Pipe 12  

Inflow       0.98 

Outflow       0.98 
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RESTRICTIONS 

Pas 1. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

Restriction 1 

from Pipe 2 to Pipe 3     0.98 

from Pipe 3 to Pipe 2     0.98 

Restriction 2 

from Pipe 4 to Pipe 5     0.98 

from Pipe 5 to Pipe 4     0.98 

Restriction 3 

from Pipe 6 to Pipe 7     0.98 

from Pipe 7 to Pipe 6     0.98 

 

PIPES 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General pentru deschiderea ferestrei de lucru (figura 4.13). 

Pentru fiecare conductă din cadrul modelului introduceți datele din tabelul 4.2. Valoa-

rea inițială de (100000 mm) este utilizată pentru caracterizarea parametrului general 

Bending Radius. În subgrupul Initialization, selectați Global set din meniul Prefe-

rence. 

 

  
Fig. 4.13 Opțiunea GENERAL 
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Tabel 4.2 Caracteristicile elementelor Pipes 

Pipe No. Pipe 

Length 

(mm) 

Diameter  

 

(mm) 

Friction 

Coeff 

(-) 

Heat 

Transfer 

(-) 

Wall 

Temp 

(degC) 

Global Inititi-

alization 

Pipe 1 75 54 0.019 1 20 Set 1 

Pipe 2 48 47 0.019 1 20 Set 1 

Pipe 3 32 34 0.019 1 20 Set 1 

Pipe 4 72 34 0.019 1 20 Set 2 

Pipe 5 140 34 0.019 1 20 Set 2 

Pipe 6 60 31 0.019 1 520 Set 3 

Pipe 7 380 TABLE 0.019 1 520 Set 3 

Pipe 8 400 TABLE 0.019 1 420 Set 4 

Pipe 9 280 40 0.019 1 260 Set 4 

Pipe 10 100 37 0.019 1 260 Set 4 

Pipe 11 150 48 0.019 1 90 Set 4 

Pipe 12 250 10 0.019 1 260 Set 4 

 
Deoarece conductele 7 și 8 sunt atribuite elementului catalizator, acestea nu 

au un diametru constant pe toată lungimea lor (vezi forma constructivă a unui ele-

ment catalizator) și de aceea trebuie definite cu ajutorul funcțiilor de parametrizare 

tabelare (tabelul 4.3).  

Pentru aceasta se face click pe simbolul , iar la deschiderea sub meniului se 

selectează opțiunea Table (figura 4.14). Pentru activarea câmpurilor de introducere a 

datelor de mai jos se selectează opțiunea Insert Row. 

 

  
Fig. 4.14 Opțiunea GENERAL – selectarea opțiunii Table 
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Tabel 4.3 Funcțiile de parametrizare tabelare 

Pipe No. Location X 

(mm) 

Diameter Y 

(mm) 

Pipe 7 0 31 

 70 35 

 380 35 

Pipe 8 0 35 

 70 31 

 400 31 

 

MEASURING POINT 

Introducerea punctelor de măsurare și monitorizare în cadrul unui model apare 

ca și o necesitate în achiziția unor parametrii specifici, pentru analiza suplimentară a 

acestora (pe lângă valorile reieșite din simularea modelului).  

În cazul de față ne interesează care este variația coeficientului de umplere (sau 

randamentul volumetric) în cadrul unui ciclu funcțional al motorului cu aprindere prin 

scânteie studiat. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 4.15 și ta-

belul 4.4): 

 

  
Fig. 4.15 Opțiunea GENERAL 
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Tabel 4.14 Amplasarea punctelor de măsurare 

Measuring Point Location of Measuring Point 

from Upstream Pipe End (mm) 

Output Extension 

Measuring Point 1 75 Standard 

Measuring Point 2 0 Standard 

Measuring Point 3 0 Standard 

Measuring Point 4 140 Standard 

Measuring Point 5 0 Standard 

Measuring Point 6 0 Standard 

Measuring Point 7 120 Extended 

Measuring Point 8 300 Standard 

Measuring Point 9 400 Standard 

Measuring Point 10 0 Standard 

 

Reference Point for Volumetric Efficiency 

Selectați opțiunile Simulation -> Volumetric Efficiency pentru deschiderea fe-

restrei de lucru. Selectați Measuring Point 2 ca și element de referință. 

 

Rularea simulării computerizate (Run Simulation) 

Selectați opțiunile Simulation -> Run din meniul de bază sau click pe butonul 

din bara de instrumente         pentru deschiderea ferestrei de lucru (figura 4.16). 

 

  
Fig. 4.16 Opțiunea RUN SIMULATION 

 

Cases: selectați toate cazurile de simulare (all Cases), sau doar un caz particular 

care interesează (figura 4.17). 
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Fig. 4.17 Opțiunea RUN SIMULATION 

 

Tasks: selectați ca fiecare caz să conțină seturile de date necesare a fi analizate și 

rezultate în urma procesului de simulare (all Tasks: Model Creation, Cycle Simula-

tion, Creation of Series Results – necesar când se simulează funcționarea motoru-

lui la diferite turații sau în diferite regimuri de funcționare). 

Selectați cazul necesar a fi rulat (simulat). 

Opțiunea Select All permite ca toate cazurile considerate să fie active (și să fie 

simulate). Pentru începerea efectivă a procesului de simulare click pe butonul Run, 

iar în fereastra ce se va deschide se poate urmări desfășurarea și informații supli-

mentare privind procesul de simulare (figura 4.18). 

Odată cu finalizarea procesului de simulare faceți click pe butonul OK pentru 

ieșire din această fereastră de lucru, iar după aceea, alegeți opțiunea Close pentru 

ieșirea din fereastra de lucru Simulation Status (figura 4.19). 

La sfârșitul sesiunii de lucru, toate operațiile efectuate conform cu algoritmul de 

lucru al laboratorului se salvează folosind comanda din meniul programului Save As 

/ Save. 
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Fig. 4.18 Derularea procesului de simulare 

 

  
Fig. 4.19 Încheierea procesului de simulare 
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Laborator 5: 

Procesarea și analiza rezultatelor ob-

ținute prin simulare 

 

Scop 

 Procesarea grafică și prezentarea datelor obținute, pentru integrarea lor ulteri-

oară în cadrul unui raport de cercetare. 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a programelor de post-procesare în vederea 

afișării, analizei și interpretării datelor obținute prin simulare computerizată; 

 Însușirea de competențe în realizarea unui raport de cercetare. 

 

Prezentarea lucrării 

Lucrarea de laborator nr. 5 prezintă posibilitățile de exploatare a rezultatelor 

obținute în urma simulării computerizate, prin utilizarea programului specific de post-

procesare Impress Chart (integrat în pachetul de programe AVL AST). 

Se prezintă detaliat funcțiunile disponibile, modalitățile și metodele de afișare, 

prezentare, analiză și interpretare a datelor, în scopul includerii ulterioare a acestora 

în cadrul unui raport de cercetare legat de tema studiată. 

 

Desfășurarea lucrării 

Aplicațiile practice din cadrul acestei lucrări de laborator se vor baza pe (vor 

utiliza) datele obținute în urma simulărilor efectuate pe baza exemplului de model din 

cadrul Laboratorului de Simulare Computerizată. Completarea lucrărilor aplicative 

propuse în cadrul acestui laborator se va efectua conform algoritmului de lucru pre-

zentat în cele ce urmează. 
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Procesarea și afișarea grafică a rezultatelor  

Utilitarul Impress Chart este utilizat pentru post-procesarea datelor obținute 

prin simularea programelor conținute în pachetul software AVL AST (inclusiv pentru 

programul AVL BOOST). Accesul la funcțiunile acestui utilitar de post-procesare se 

poate realiza în mai multe moduri: 

1. Prin acționarea butonului  din bara de  unelte, imediat după terminarea 

procesului de simulare; 

2. Prin accesul la meniul programului (opțiunea din meniul Impress Chart: Si-

mulation -> Show Results) (figura 5.1); 

3. Prin acces la meniul de la start a pachetului de programe AVL AST (opțiu-

nea din meniu de start AVL AST: Impress Chart) (figura 5.2). 

 

 

Fig. 5.1 Meniul Simulation – Show Results 

 

 

Fig. 5.2 Meniul AVL AST – Impress Chart 
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Pentru exemplul aplicativ, utilizând modelul de motor cu aprindere prin scânteie 

simulat, din bara de unelte se deschide utilitarul Impress Chart prin accesarea icon-

ului corespondent (figura 5.3). 

 

  
Fig. 5.3 Icon-ul Show Results 

 

În fereastra deschisă există următoarele zone de lucru specifice (figura 5.4): 

1. Zona de afișare a rezultatelor simulării (bazele de date rezultate în urma si-

mulării); 

2. Zona de lucru (de inserare grafică a rezultatelor, zona Layer-elor); 

3. Bara de meniu (Menu Bar (a), Icon Toolbar (b), Plot Object Toolbar (c)). 

 

  
Fig. 5.4 Fereastra Impress Chart 

 

1 

2 

3 

b 

a 
c 
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Pentru accesul la rezultatele (seturile specifice) obținute în urma simulării com-

puterizate (pentru întregul model și/sau pentru fiecare element component al modelu-

lui) se face dublu click pe linia din zona 1 a ecranului ce afișează cazul de simulare 

considerat (Case_Set_1 Cae_1 simulation.dir). 

Se vor deschide două directoare (baze de rezultate): Transient și Traces (fi-

gura 5.5). 

Rezultatele simulărilor computerizate ce se doresc a fi afișate grafic se aleg din 

cele două baze de rezultate, în funcție de următorul specific: 

 Transients: conține rezultate ale simulărilor raportate la timp (s) pe abscisa 

graficului (valorile medii ale totalității ciclurilor de simulare executate de pro-

gram și setate inițial de utilizator). 

 Traces: conține rezultate ale simulărilor raportate la unghiul de rotație al arbo-

relui cotit (deg) – valorile rezultate în urma simulării ultimului ciclu de simulare 

din totalitatea acestora. 

 

  
Fig. 5.5 Bazele de rezultate: Transient și Traces 

 

Primul pas în afișarea datelor sub forma de grafice este inserarea formei de 

bază a ferestrei grafice (a Layer-ului) așa cum este prezentat în figura 5.6.  

Dimensiunile geometrice ale ferestrei grafice (a Layer-ului) se pot modifica prin 

selectarea inițială a acestuia (click pe Options – Layer Packing).  

Din fereastra Layer Packer se pot modifica caracteristicile Layer-ului și anu-

me: direcția de orientare (Direction), numărul de linii și coloane (Num), alinierea la 

margini (Margin), respectiv spațierea (Spacing) (figura 5.7). 
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Fig. 5.6 Inserarea Layer-ului 

 

 
Fig. 5.7 Modificarea dimensiunilor Layer-ului 

 

Pentru afișarea unui număr mai mare de parametrii, sau a unor serii multiple de 

rezultate se vor introduce mai multe pagini, sau mai multe seturi de pagini. Acestea 

se introduc acționând butonul Report din zona de afișare a rezultatelor simulării prin 

comanda Page Set pentru un nou set de pagini, respectiv Page pentru o pagină no-

uă (figura 5.8). 

 

Inserăm un nou Layer pentru 
încărcarea graficelor 
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Fig. 5.8 Inserarea paginilor / seturilor de pagini 

 

Pentru anumite seturi de simulări existe modele predefinite pentru grafice 

(BOOST Templates) care se încărcă acționând butonul Templates din zona de afi-

șare a rezultatelor simulării (figura 5.9). 

 

 
Fig. 5.9 Modele predefinite pentru grafice (BOOST Templates) 

 

Pentru realizarea graficelor există două tipuri de Layer-re: 

 Cartezian în coordonate X/Y, caracterizat de următoarele elemente: axa de co-

ordonate X, axa de coordonate Y, Colorbar, Data Marker, Data Reader, 

Statistics, etc.) prezentată în figura 5.10. 

 Polar în coordonate Φ/R caracterizat de următoarele elemente: axa radială R, 

axa Φ, Statistics, etc.) prezentată în figura 5.11. 
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Fig. 5.10 Layer cartezian în coordonate X/Y 

 

 
Fig. 5.11 Layer polar în coordonate Φ/R 

 

Accesul la proprietățile unui Layer se realizează prin una din următoarele pro-

ceduri (figura 5.12): 

 dublu click pe fereastra Layer-ului 

 click dreapta pe fereastra Layer-ului și selectați Properties din meniu (selectați 

Meniu Bar – Layer – Properties) 

 

 
Fig. 5.12 Proprietățile Layer-ului 
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Layer-ele de tip cartezian pot fi implementate în trei variante diferite (figura 

5.13): 

 

 
Fig. 5.13 Tipuri de Layer-e carteziene 

 

 Regular – graficul este reprezentat în coordonate X/Y (figura 5.14a); 

 Fringe (Campbell) – graficul este reprezentat prin interpolarea unui parametrul 

indicat pe axa Y (figura 5.14b); 

 Waterfall – graficul este prezentat sub forma de cascadă pentru a evidenția 

efectul cumulativ al secvențelor de date cu valori pozitive sau negative (figura 

5.14c); 

 Stacked – graficul este reprezentat prin însumarea punctelor de pe grafic după 

un model liniar sau logaritmic (figura 5.14d). 

 

Afișarea rezultatelor în fereastra grafică 

Pentru accesul la datele rezultate prin simulare se deschid directoarele Tran-

sient sau Traces. În cazul nostru vom dori să realizăm o reprezentare grafică (varia-

ția) a presiunii în cilindru pe parcursul unui ciclu motor.  

Rezultatele se transpun pe grafic (Layer) cu dublu click pe parametrul care se 

dorește analizat (figura 5.15).  
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a) 

 

b) 

 

c) 

 

d) 

Fig. 5.14 Grafice construite pe tipuri de Layer-e carteziene: 

a – regular, b – Fringe (Campbell), c – Waterfall, d – Stacked 
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Fig. 5.15 Rezultatele simulărilor computerizate 

 

Dacă se dorește ca în cadrul aceluiași Layer să fie reprezentate grafic variația 

a mai multor parametri se vor efectua următoarele operații: 

 Se inserează Layer-ul 1 și prin deschiderea ferestrei de definire a proprietăților 

(selectare Layer -> dreapta click -> Properties), se modifică forma acestuia 

(figura 5.16). 

 

  
Fig. 5.16 Inserare Layer 1 

 

 Se selectează Layer-ul 1 și se inserează un nou Layer (Layer 2). La fel ca și 

în cazul precedent se vor defini proprietățile Layer-ului 2. 

În mod analog se vor insera încă două ferestre grafice (Layer-ele 3 și 4), se 

vor defini proprietățile acestora (figura 5.17). 
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Fig. 5.17 Inserare Layer 2, 3 și 4 

 

Odată finalizate toate aceste operații, se vor putea reprezenta pe același grafic 

(figura 5.18) curbele (variațiile) corespunzătoare presiunii în cilindru (Pressure), a 

temperaturii (Temperature) și a volumului de amestec din cilindru (VolumeWork) 

pentru cazul de simulare deja studiat (marcare Layer cu simplu click și click pe fieca-

re parametru ce se dorește a fi afișat). 

 

  
Fig. 5.18 Inserare rezultate simulare Multi-Layer 

 

În situația în care sunt inserate mai multe categorii de rezultate pe același gra-

fic, pentru a corela dimensiunile mărimilor de pe axa Y, suprafața utilă a Layer-ului 

poate fi redimensionată în raport cu Layer-ul de referință (Layer 1) (figura 5.19). 

 

Inserăm un nou Layer  
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Fig. 5.19 Redimensionare Layer 

 

Schimbarea proprietăților axelor (a intervalului de măsură) 

Se observă în figura 5.15, variația presiunii din interiorul camerei de ardere pe 

parcursul unui ciclu motor. Specialiștii în motoare termice preferă o altă reprezentare, 

reprezentare care pune accentul (se prezintă detaliat) pe zona de creștere a presiunii 

datorită procesului de ardere a combustibilului. 

Pentru a realiza acest lucru se procedează în felul următor: 

- Din meniul Operations alegeți opțiunea Geometric Transformation; 

- Selectați curba de presiune (Pressure Cylinder (Pa) (Layer_1)); 

- Introduceți în câmpul Translated by valoarea de (X = -360 deg, Y = 0); 

- Confirmați operațiunea prin butonul Apply to (figura 5.20). 

 

  
Fig. 5.20 Opțiunea Geometric Transformation 
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- Din meniul Operations alegeți opțiunea Cyclic X Shift; 

- Selectați curba de presiune (Pressure Cylinder (Pa) (Layer_1)); 

- Introduceți valoarea de (360 deg) în câmpul Add to X; 

- Confirmați operațiunea prin butonul Apply to (figura 5.21). 

 

  
Fig. 5.21 Opțiunea Cyclic X Shift 

 

Astfel intervalul de măsură se transformă din intervalul (0, 720) în (-360, 360) 

grade RAC), iar zona de creștere a presiunii din cilindrul motor datorită procesului de 

aprindere și ardere este situată în zona de mijloc a ecranului (figura 5.22). 

 

  
Fig. 5.22 Graficul presiunii în intervalul transformat 
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Modificarea proprietăților curbelor de variație 

Sunt cazuri în care datorită multitudinii curbelor afișate în aceiași fereastră gra-

fică (Layer) sunt necesare delimitări/particularizări ale fiecărei dintre curbe prin tipul, 

grosimea și culoarea liniei de reprezentare. 

Modificarea aspectului graficelor obținute se realizează prin efectuarea unui 

click dreapta pe foaia activă de lucru, apoi click pe comanda Style (1) și se va des-

chide fereastra Colors and Styles (2) (figura 5.23).  

 

  
Fig. 5.23 Modificarea aspectelor graficelor 

 

Exportarea datelor afișate grafic 

Dacă se dorește analiza și interpretarea rezultatelor obținute în urma simulări-

lor computerizate în alte utilitare de post-procesare, acestea se pot exporta într-un 

format compatibil Excel cu opțiunea Layer -> Export -> Ascii (CSV)… (figura 5.24):  

 

 
Fig. 5.24 Exportați rezultatele simulărilor computerizate 

1 

2 

xls 
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Instrumente de analiză statistică 

Utilitarul Impress Chart oferă funcțiuni de utilizare a metodelor de analiză sta-

tistică a curbelor (variațiilor grafice). Astfel, se pot identifica și măsură o serie de pa-

rametrii statistici ce prezintă importanța în analiza parametrilor funcționali ai unui mo-

tor cu ardere internă pe durata unui ciclul motor: valoarea medie, minimă și maximă, 

cantitatea totală, valoarea specifică pentru o valoare cerută a axelor graficului.  

Creați un Layer nou în care să reprezentați curba de variație a ratei de căldură 

eliberate prin arderea combustibilului (ROHR – Rate Of Heat Release) (figura 5.25). 

 

 
Fig. 5.25 Curba de variație a ratei de căldură eliberate ROHR 

 

Pentru obținerea datelor statistice referitoare la curba reprezentată, se modifică 

proprietățile graficului construit din opțiunea click dreapta pe zona de lucru a graficu-

lui Properties -> Layer Properties -> General (figura 5.26): 

 

 
Fig. 5.26 Curba de variație a ratei de căldură eliberate ROHR 



65 

 

În fereastra Layer Properties se adăugă următoarele elemente de monitoriza-

re a parametrilor studiați: 

Data Reader – Cursor Reader – Statistics – Colorbar (figura 5.27) 

 

 
Fig. 5.27 Exportați rezultatele simulărilor computerizate 

 

În exemplul prezentat se poate observa că valoarea maximă a ratei de căldură 

eliberate datorită arderii combustibilului are o valoare maximă de 58.8296 J/deg, iar 

cantitatea totală eliberată pe parcursul unui ciclu motor este de 1.8281 J/deg (figura 

5.28). 

 

 
Fig. 5.28 Valorile parametrilor monitorizați 

 

La sfârșitul sesiunii de lucru, toate operațiile efectuate conform cu algoritmul de 

lucru al laboratorului se salvează folosind comanda din meniul programului Save As 

/ Save. 
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Laborator 6: 

Implementarea elementelor de mana-

gement, comandă și control (ECU) în 

modelele numerice 

 

Scop 

 Crearea, parametrizarea și simularea unui model complex de motor cu ardere 

internă ce are în componență elemente de management, comandă și control. 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților superioare de utilizare a metodelor numerice moderne de 

investigare a proceselor funcționale ale motoarelor cu ardere internă; 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată; 

 Însușirea de cunoştinţe privind elementele de management, comandă și control 

din componența motoarelor cu ardere internă. 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în implementarea unor elemente de management (ECU), comandă și 

control în structura unui motor monocilindric cu aprindere prin scânteie. Se prezintă 

detaliat modul de modificare a modelului de motor supus simulării, precum și a mo-

dului de parametrizare a fiecărui element nou din structura modelului utilizat în simu-

larea computerizată. 
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Desfășurarea lucrării 

Lucrarea de laborator nr. 6 se desfășoară prin parcurgerea algoritmului prezen-

tat în cele ce urmează, în scopul realizării unei aplicații practice de inserare a unui 

modul electronic de comandă (ECU) în modelul unui motor monocilindric cu aprinde-

re prin scânteie (MAS).  

Rolul ECU în cadrul modelului general a motorului monocilindric cu aprindere 

prin scânteie, este acela de a asigura permanent un raport de  dozaj egal cu valoa-

rea de 11, pentru toată gama de turație a motorului. În funcție de semnalul pe care 

ECU îl recepționează de la clapeta de accelerație (Restriction 1 – R1) va determina 

durata semnalului de deschidere a injectorului (Injector 1 – I 1). 

Particular, în cazul ce urmează a fi prezentat, se va utiliza modelul de motor 

deja construit prin parcurgerea etapelor prezentate în cadrul laboratoarelor 3 – 5, 

conform algoritmului ce urmează a fi prezentat: 

 

Pas 1. Încărcarea modelului de motor monocilindric 

Modelul de motor monocilindric se încarcă în zona de lucru, prin alegerea opți-

unii din meniul programului File -> Open sau prin accesarea butonului din bara de 

unelte corespunzător opțiunii Open/Load (figura 6.1).  

 

 

Fig. 6.1 Încărcarea modelului de motor monocilindric 
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Pas 2. Inserarea în model a elementului ECU 

Alegerea unui element corespondent modulului de comandă și control ECU (fi-

gura 6.2) se realizează cu ajutorul mouse-ului (dublu click pe element în zona de 

identificare a elementelor “Element Tree”). Pentru poziționarea în cadrul modelului 

deja încărcat în zona (fereastra) de lucru, se selectează elementul (simplu click), se 

menține apăsat butonul stâng al mouse-ului și se mută elementul acolo unde se do-

rește (figura 6.3). 

 

 

Fig. 6.2 Selectarea elementului de comandă și control ECU 

 

 

Fig. 6.3 Inserarea elementului de comandă și control ECU în zona de lucru 
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Pas 3. Conectarea elementului ECU cu modelul 

Conexiunea dintre elementul ECU și modelul de motor monocilindric se reali-

zează prin selectarea opțiunii “Connection” din bara de unelte (figura 6.4), iar prin 

conexiune se atașează elementelor conectate (se selectează capetele conexiunii și 

se conectează cu elementele specifice, unind ancorele elementelor). În cazul de față 

elementul ECU 1 va fi conectat cu următoarele elemente ale modelului de motor: 

Restriction 1 (clapeta de accelerație), Cylinder 1 (cilindru motor) și Injector 1 

(injectorul amplasat în galeria de admisie) (figura 6.5). 

 

 

Fig. 6.4 Conectarea elementului ECU cu modelul de motor monocilindric 

 

 

Fig. 6.5 Conexiunile cu elementele modelului de motor 
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Conexiunile realizate apar cu linii de culoare albastră deoarece sunt conexiuni 

electrice. 

 

Pas 4. Setări Generale ECU 

Dublu click pe elementul ECU pentru editare. Click pe opțiunea General (figura 

6.6). 

Selectați opțiunea de introducere tabelară a variației semnalului (Load Signal -

> Table). Introduceți valorile de mai jos (tabelul 6.1) pentru realizarea unei variații a 

semnalului în funcție de timp (figura 6.7). 

 

 

Fig. 6.6 Setările generale ECU 

 

Tabel 6.1 Variația semnalului 

Nr. Time (x) 

(sec) 

Load Signal (y) 

(-) 

1 0.00 0.50 

2 0.40 0.50 

3 0.45 1.00 

4 1.00 1.00 
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Fig. 6.7 Tabelul Load Signal 

  

Pas 5. Engine Control Unit - Map Specification 

Click pe opțiunea Map Specification. Inserați în rândurile tabelului elementele 

controlate și comandate de ECU. În cazul nostru Restriction 1 și Injector 1 (figura 

6.8). 

 

 

Fig. 6.8 Opțiunea Map Specification – inserarea elementelor 
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Faceți click pe butonul de acces la meniu și alegeți parametrul de definește fie-

care element controlat și comandat de ECU elementul (opțiunea necesară). Pentru 

Restriction 1 (coeficientul de curgere – Flow Coefficient) iar pentru Injector 1 (ra-

portul de dozaj – A/F Ratio) (figura 6.9). 

 

 

Fig. 6.9 Opțiunea Map Specification – definirea parametrilor 

 

Pas 6. Engine Control Unit – Maps Flow Chart 

Click pe opțiunea Maps Flow Chart. Se va deschide ecranul în care este pre-

zentat modul de compunere și funcționare a ECU pe baza hărților specifice procese-

lor funcționale ale motorului (figura 6.10). În timpul introducerii datelor necesare pa-

rametrizării variabilelor luate în considerare va fi semnalat pe această diagramă locul 

în care se realizează setările. 

 

 

Fig. 6.10 Opțiunea Maps Flow Chart 
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Pas 7. Engine Control Unit – R1 Input of Maps 

Click pe opțiunea R1 Input of Maps. Selectați pentru meniul Baseline Value 

opțiunea Map pentru parametrul R1 Flow Coefficient (figura 6.11). 

 

 

Fig. 6.11 Opțiunea R1 Input of Maps 

 

Pas 8. Engine Control Unit – R1 Flow Coefficient Baseline Map  

Click pe opțiunea Baseline Map. Introduceți datele din figura 6.12, pentru defi-

nirea poziției de deschidere a clapetei de accelerație (poziție definită prin coeficientul 

de curgere) în funcție de anumită valoare a semnalului (Load Signal).  

 

 

Fig. 6.12 Opțiunea R1 Flow Coefficient Baseline Map 
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Click pe opțiunea Maximum Map și introduceți datele din figura 6.13. 

 

 

Fig. 6.13 Opțiunea R1 Flow Coefficient Maximum Map 

 

Click pe opțiunea Minimum Map și introduceți datele din figura 6.14. 

 

 

Fig. 6.14 Opțiunea R1 Flow Coefficient Minimum Map 

 

Pas 9. Engine Control Unit – I1 Input of Maps 

Click pe opțiunea I1-A/F Ratio. Selectați pentru meniul Baseline Value opțiu-

nea Actual Value pentru parametrul I1 A/F Ratio (figura 6.15). 
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Fig. 6.15 Opțiunea I1 A/F Ratio Input of Maps 

 

Click pe opțiunea I1 A/R Ratio -> Maximum Map și introduceți datele din figura 6.16. 

 

 

Fig. 6.16 Opțiunea I1 A/F Ratio Maximum Map 

 

Click pe opțiunea I1 A/R Ratio -> Minimum Map și introduceți datele din figura 6.17. 

 

 

Fig. 6.17 Opțiunea I1 A/F Ratio Minimum Map 
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Faceți dreapta click pe opțiunea I1-A/F Ratio și alegeți din meniul deschis 

Steady State Map: Insert. Se creează o nouă hartă în cadrul ECU pentru a com-

pensa/corecta diferența raportului de dozaj ce există între zona în care are loc injec-

ția de combustibil și cel din interiorul cilindrului (figura 6.18). 

 

 

Fig. 6.18 Opțiunea I1 A/F Ratio Steady State Map: Insert 

 

Click pe opțiunea I1 A/R Ratio -> Steady Step Map și introduceți următoarele 

date în tabelul A/F Ratio (tabelul 6.2): 

Tabel 6.2 Variația semnalului 

Nr. A/F Ratio  A/F Ratio (corecție) 

1 8 1.2 

2 9 0.8 

3 10 0.5 

4 10.5 0.2 

5 11 0.0 

6 11.5 -0.2 

7 12 -0.5 

8 13 -0.8 

9 14 -1.1 

10 15 -1.3 

11 18 -1.5 

 

Nu uitați să apăsați butonul Apply pentru ca datele deja introduse (și setările 

astfel realizate) să fie salvate ! Înainte de a porni simularea salvați modelul ! 
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Pas 10. Click pe opțiunea Simulation Controls -> Globals ->Time Step Control 

Setați parametrul Maximum Calculation Period la o valoare arbitrară de 50 

cicluri motor (Cycles) (figura 6.19). 

 

 

Fig. 6.19 Parametrul Maximum Calculation Period 

 

Pas 11. Click pe opțiunea Simulation -> Run (figura 6.20) 

Urmați pașii și indicațiile prezentate în cadrul laboratorului 5. Odată cu finaliza-

rea procesului de simulare faceți click pe butonul OK pentru ieșire din această fe-

reastra Task Information/Simulation Status (figura 6.21). 

 

  
Fig. 6.20 Opțiunea RUN SIMULATION 
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Fig. 6.21 Finalizarea procesului de simulare 

 

Pas 12. Click pe opțiunea Simulation - Show Results 

Urmați pașii și indicațiile prezentate în cadrul laboratorului 5 (figura 6.22). 

 

 

Fig. 6.22 Opțiunea Simulation - Show Results 

 

Deschideți pe rând folderul Engine 1 și după aceea folderul Transients (din 

zona de acces la datele simulării). Selectați parametrul ce definește axa X de coor-

donate ca fiind End of Cycle (figura 6.23). 
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Fig. 6.23 Definirea coordonatelor pentru axa X 

 

Introduceți în pagina de lucru 3 ferestre de afișare grafică (Layer-e separate). 

Încărcați în fiecare dintre aceste: 

 Layer 1 Transients/Restriction 1/AttachedPipe 2/FlowCoeff (figura 6.24); 

 Layer 2 Transients/ECU1/Load Signal (figura 6.25); 

 Layer 3 Transients/Cylinder 1/Start of High Pressure/UnBrnd-Air/Fuel-Ratio (fi-

gura 6.26). 

 

 

Fig. 6.24 Rezultatele pentru Flow Coefficient of R1 
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Fig. 6.25 Rezultatele pentru Load Signal of ECU1 

 

 

Fig. 6.26 Rezultatele pentru A/F Ratio of Cylinder 1 
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Laborator 7: 

Modelarea și simularea unui motor po-

licilindric cu aprindere prin comprima-

re. Construcție model și parametrizare 

generală motor. 

 

Scop 

 Crearea, parametrizarea și simularea unui model de motor cu aprindere prin 

comprimare policilindric. 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a unor metode moderne de investigare a pro-

ceselor funcționale ale motoarelor cu ardere internă; 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată. 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în modelarea unui motor cu aprindere prin comprimare policilindric. Se 

prezintă detaliat modul de realizare a modelului de motor supus simulării, precum și 

a modului de parametrizare a fiecărui element component al modelului. 

 

Desfășurarea lucrării 

Lucrarea de laborator se desfășoară prin parcurgerea algoritmului prezentat în 

cele ce urmează, în scopul realizării unei aplicații practice de modelare a unui motor 

policilindric cu aprindere prin comprimare. 

Modelul se construiește prin plasarea elementelor componente în interiorul zo-
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nei de lucru și interconectarea lor prin intermediul elementelor de conectare “Pipes”. 

Nu este necesară o ordine prestabilită de amplasare a elementelor sau a poziționării 

lor exacte în interiorul zonei de lucru. 

Alegerea unui element component și amplasarea lui se realizează prin efectua-

rea cu ajutorul mouse-ului (dublu click pe element în zona de identificare a elemente-

lor “Element Tree”). Pentru poziționarea în cadrul zonei de lucru (de creare a mode-

lului) se selectează elementul (simplu click), se menține apăsat butonul stâng al mo-

use-ului și se mută elementul acolo unde se dorește (figura 7.1). 

 

 

Fig. 7.1 Inserarea unui element în zona de lucru 

 

Particular, în cazul ce urmează a fi prezentat, modelul de motor ales a fi mode-

lat și simulat se compune din următoarele elemente componente (figura 7.2): 

 1 buc. motor (Engine) 

 1 buc unitate electronică de control (Engine Control Unit) 

 4 buc. cilindru motor (Cylinder) 

 1 buc. filtru de aer (Air Cleaner) 

 1 buc. catalizator (Catalyst) 

 1 buc. turbocompresor (Turbocharger) 

 2 buc. răcitoare (Cooler) 

 2 buc. elemente intrare/ieșire – admisie/evacuare (System Boundaries)  

 3 buc. volume de compensare (Plenum) 

 5 buc. restricții (Restrictions) 
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 5 buc. joncțiuni (Junction) 

 12 buc. puncte de măsurare și monitorizare (Measuring Points) 

 32 buc. conexiuni (Pipes) 

 

 
Fig. 7.2 Elementele modelului de motor cu aprindere prin comprimare  

 

Conexiunea dintre elemente (figura 7.3) se realizează prin selectarea opțiunii 

“Connection” din bara de unelte, iar prin conexiune se atașează elementelor conecta-

te (se selectează capetele conexiunii și se conectează cu elementele specifice, unind 

ancorele elementelor). 

Conexiunile mecanice (portocaliu) și conductele de curgere pentru fluide (ne-

gru), trebuie definite corespunzător caracteristicilor lor, iar conexiunile electrice (al-

bastru) sunt considerate a fi conectori de legătură care nu se definesc (figura 7.4). 

Pentru schimbarea direcției de conectare se folosește comanda Change Di-

rection din bara de meniu, iar pentru schimbarea legăturilor efectuate între elemente 

se folosește comanda Change Connection. 

Modelul creat prin efectuarea operațiilor anterior prezentate va avea forma ce-

lui prezentat în figura 7.5. 
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Fig. 7.3 Conectarea elementelor 

 

   
a) b) c) 

Fig. 7.4 Conectarea elementelor constructive: 

a – conexiune pentru fluide (negru), b – mecanică (orange), c – electrică (albastru). 

 

 

 
Fig. 7.5 Model de motor cu aprindere prin comprimare policilindric 
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Introducerea datelor generale privind modelul 

Înainte de a defini și parametriza fiecare element în funcție de specificul lui, 

prin utilizarea programului de modelare și simulare AVL BOOST este obligatoriu să 

fie introduse datele generale privind modelul și condițiile generale de simulare. 

Definirea și introducerea datelor generale (globale) se realizează prin accesa-

rea din meniu a opțiunii Simulation -> Control, ceea ce va duce la deschiderea ur-

mătoarei ferestre de lucru. 

 

Pas 1. Opțiunea SIMULATION TASKS 

Click pe Simulation -> Tasks și selectați Cycle Simulation. 

 

Pas 2. Opțiunea CYCLE SIMULATION 

Click pe subgrupul Cycle Simulation ceea ce va duce la deschiderea urmă-

toarei ferestre de lucru (figura 7.6): 

 

 
Fig. 7.6 Opțiunea CYCLE SIMULATION 

 

Înserați următoarele date: 

Species Transport     Classic (default)  

Simulation Interval: End of Simulation 10 cycles (7200 deg) 

Spatial Pipe Discretization 

Average Cell Size     30 mm 
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Pas 3. Opțiunea CLASSIC SPECIES SETUP 

Click pe Classic Species -> Setup ceea ce va duce la deschiderea următoarei 

ferestre de lucru (se vor păstra valorile afișate în figura 7.7): 

 

 
Fig. 7.7 Opțiunea CLASSIC SPECIES SETUP 

 

Pas 4. Opțiunea INITIALIZATION 

Click pe Initialization pentru deschiderea ferestrei “Initialization”. Selectați 

A/F-Ratio din meniul Ratio. Selectați Add Set și introduceți datele din figura 7.8 și 

tabelul 7.1. 

 

 
Fig. 7.8 Condițiile de inițializare 
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Tabel 7.1 Condițiile de inițializare 

Set Pressure 

(bar) 

Temperature 

(degC) 

Fuel Va-

pour (-) 

Combustion 

Products (-) 

A/F Ratio 

(-) 

1 0.969 20 0.000 0.000 14.57 

2 0.960 35 0.000 0.000 14.57 

3 1.000 80 0.000 0.000 14.57 

4 0.986 70 0.000 0.000 14.57 

5 1.000 280 0.000 1.000 14.57 

6 0.986 80 0.000 1.000 14.57 

7 0.990 250 0.000 1.000 14.57 

8 0.985 230 0.000 1.000 14.57 

9 0.975 200 0.000 0.600 14.57 

10 0.970 40 0.000 0.200 14.57 

 

Pas 5. Opțiunea RESTART CONTROL 

Click pe Restart Control pentru deschiderea ferestrei de lucru. Selectați Spe-

cific Interval din meniul Restart File Saving Interval și introduceți valoarea de (720 

deg) pentru Saving Interval (figura 7.9). 

 

 
Fig. 7.9 Opțiunea RESTART CONTROL 
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Pas 6. Opțiunea OUTPUT CONTROL 

Click pe Output Control și introduceți valoarea de (0.1 deg) pentru Saving In-

terval (figura 7.10). Click OK. 

 

 
Fig. 7.10 Opțiunea OUTPUT CONTROL 

 

Introducerea datelor specifice fiecărui element al modelului 

În modelul general creat în zona de lucru, selectați elementul dorit a fi definit, 

printr-un click cu butonul stânga al mouse-ului și după aceasta operație deschideți o 

fereastră de dialog prin acționarea butonului dreapta al mouse-ului. Selectați Proper-

ties din fereastra de dialog și se va deschide o fereastră de lucru în care pot fi inse-

rate datele specifice elementului selectat. 

Este importantă mențiunea că datele ce caracterizează un element pot fi copia-

te și transmise unui alt element omolog prin operația Element -> Copy Data. 

 

ENGINE 

Pas 1. Opțiunea GENERAL 

Click pe Engine pentru deschiderea ferestrei de lucru (figura 7.11). Introduceți 

valoarea de (2500 rpm) pentru Engine Speed. 
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Fig. 7.11 Opțiunea GENERAL 

 

Pas 2. Opțiunea Cylinder/RPE-Rotor Setup 

În subgrupul Cylinder/RPE-Rotor Setup, se selectează opțiunea Identical 

Cylinders. În fereastra Firing Order se stabilește ordinea de aprindere a cilindrilor 

motorului (0 – 360 – 540 – 180 care corespunde 1 – 3 – 4 – 2) (figura 7.12). 

 

 
Fig. 7.12 Opțiunea CYLINDER/RPE-ROTOR SETUP 

 

Pas 3. Opțiunea ENGINE FRICTION 

În subgrupul Engine Friction, opțiunea Patton, Nitschke, Heywood - Model 

cu Friction Multiplier 1 este selectată ca și opțiune generală (figura 7.13).  
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Fig. 7.13 Opțiunea ENGINE FRICTION 

 

Click pe Engine Friction: Friction Model unde se completează datele din fi-

gura 7.14: 

Cylinder Arrangement   Inline 

Type of Valve Train    SOHC- Rocker Arm 

Number of Camshafts Bearings  8 

Maximum Valve Lift    8.5 mm 

Type of Cam Follower   Flat Follower 

Oil Type      SAE 5W/30 

Oil Temperature    20 degC 

 

 
Fig. 7.14 Opțiunea FRICTION MODEL 
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CYLINDER 

Pas 1. Opțiunea GENERAL 

Click pe Cylinder pentru deschiderea ferestrei de lucru (figura 7.15). 

 

 
Fig. 7.15 Opțiunea GENERAL 

 

Introduceți următoarele valori: 

Bore:       75 mm 

Stroke:       80 mm 

Compression Ratio:     18 

Con-rod Length:     135 mm 

Piston Pin Offset:     0.3 mm 

Effective Blow by Gap:    0.001 mm 

Mean Crankcase Press:    1 bar 

Scavenge Model:     Perfect Mixing 

 

Pas 2. Opțiunea INITIALIZATION 

Click pe subgrupul Initialization pentru deschiderea ferestrei de lucru (figura 

7.16). Introduceți următoarele valori: 

Initial Conditions at EO  

(Exhaust Valve Opening) 

Pressure:       7 bar 

Temperature:      726 degC 
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Initial Gas Composition 

Ratio Type       A/F Ratio 

Ratio Value      14.57 

Fuel Vapour      0 

Combustion Products    0.6 

 

 
Fig. 7.16 Opțiunea INITIALIZATION 

 

Pas 3. Opțiunea SHP CONDITION SETTING 

Click pe subgrupul SHP Condition Setting pentru momentul de început al 

creșterii presiunii din cilindru, sau momentul când toate supapele sunt închise și se-

lectați opțiunea Mass definind următorii parametrii (figura 7.17): 

 

 
Fig. 7.17 Opțiunea SHP Condition Setting 
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SHP Condition Setting    Mass 

Pressure at SHP     2.5 bar 

Air Massflow      35 kg/h 

Fuel Massflow      1 kg/h 

Trapping Efficiency Air    1 

Trapping Efficiency Fuel    1 

Mass Fraction of Residual Gas   0 

 

Pas 4. Opțiunea COMBUSTION 

Click pe subgrupul Combustion și selectați opțiunea AVL MCC Model (mode-

lul de ardere Mixing Controlled Combustion) care estimează cantitatea de căldură 

eliberată ROHR (Rate Of Heat Release) și emisiile poluante pe baza cantității de 

combustibil din cilindru și pe baza energiei cinetice turbulente introdusă de injecția de 

combustibil pentru modul de caracterizare a căldurii rezultate în urma procesului de 

ardere (Heat Release) (figura 7.18): 

 

Heat Release      AVL MCC Model 

Vibe Parameter Fitting    Single 

Fuel Mass/Cycle     4 mg 

Mixture Preparation     Internal 

Fuel Temperature     40 degC 

 

 
Fig. 7.18 Opțiunea COMBUSTION 
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Click pe subgrupul AVL MCC Model pentru deschiderea ferestrei de lucru și 

introduceți următoarele valori (figura 7.19): 

Physical Properties 

Number of Injector Holes    7 

Hole Diameter      0.00012 m 

Rail Pressure      400 bar 

Normalised Model Parameters 

Ignition Delay Calibration    0.5 

Combustion Parameter    1 

Turbulence Parameter    1 

Dissipation Parameter    1 

EGR Influence Parameter    1 

Premixed Combustion     0.7 

Rate of Injection     calculated  

 

 
Fig. 7.19 Modelul de ardere AVL MCC 

 

Click pe subgrupul iRate (legea de injecție iRate definește injecția pe baza 

cantității de combustibil livrată de către injectoare) pentru deschiderea ferestrei de 

lucru și introduceți următoarele valori (figura 7.20): 

Fuel Density     850 kg/m3 

Ignition Timing 
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Max. Needle Lift    0.2 mm 

Delay – Start ts  300 micros Delay – Up tu   500 micros 

Delay – End te  600 micros Delay – Down td  400 micros 

Signal On (linia 1 – pilot)   -6 deg 

Signal Off (linia 1 – pilot)   -3 deg 

Signal On (linia 2 – main)   -2 deg 

Signal Off (linia 2 – main)    8 deg 

 

 
Fig. 7.20 Legea de injecție iRate 

 

Click pe subgrupul Nozzle Flow Data (debitul de combustibil (Volume Flow) 

[m3/s] injectat prin duzele injectorului (Nozzle Flow) care se calculează în funcție de 

deschiderea acului injectorului (Needle Lift) – valoarea maximă corespunde cursei 

maxime a injectorului (Max Needle Lift)) pentru deschiderea ferestrei de lucru și in-

troduceți valorile din tabelul 2 (figura 7.21): 

Tabel 7.2 Deschiderea acului injectorului 

Set Needle Lift (X) (mm) Volume Flow (Y) (m3/s) 

1 0.00 0.00 

2 0.05 7e-006 

3 0.10 1e-005 

4 0.15 1.2e-005 

5 0.20 1.25e-005 
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Fig. 7.21 Deschiderea acului injectorului 

 

Click pe subgrupul Pressure Data (graficul presiunii din cilindru din figura 7.22) 

pentru deschiderea ferestrei de lucru și încărcați datele pentru valorile presiunii în 

cilindru cu comanda Load din fișierul 1500.txt, urmând pașii din figura 7.23: 

 

 
Fig. 7.22 Graficul presiunii din cilindru 
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Fig. 7.23 Încărcarea datelor pentru presiunea din cilindru 

 

Click pe subgrupul Calculated ROI pentru deschiderea ferestrei de lucru și un-

de legea de injecție iRate va calcula și genera automat graficul pentru cele două in-

jecții: pilot și principală (figura 7.24): 

 

 
Fig. 7.24 Calculul injecției prin legea iRate 

 

Atenție !!! În situația în care legea iRate afișează un mesaj de eroare la calculul 

injecției se verifică toate datele introduse de la început în elementul cilindru – 

în special unitățile de măsură pentru aceste date (exemplu kg/h și nu kg/s). 
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Click pe subgrupul Pollutants (pentru modelul de calcul al emisiilor poluante 

de NOx, CO și Soot) pentru deschiderea ferestrei de lucru și introduceți următoarele 

valori (figura 7.25): 

NOx Production Model 

NOx Kinetic Multiplier    0.3 

NOx Postprocessing Multiplier   0.64 

CO Production Model 

CO Kinetic Multiplier    1 

Soot Production Model 

Soot Production Constant    1000 

Soot Consumption Constant   775 

 

 
Fig. 7.25 Modelul de calcul al emisiilor poluante 

 

Pas 5. Opțiunea HEAT TRANSFER 

Click pe subgrupul Heat Transfer și introduceți următoarele valori (figura 7.26): 

Cylinder       AVL 2000 

Ports       Zapf 

Piston      

Surface Area      
2

2

4500
4

mm
D

S piston 





 

Wall Temperature     CspeedTpiston deg320045.0200   

Piston Calibration Factor    1 

Cylinder Head 
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Surface Area      
2

2

5900
4

3.1 mm
D

Scilindru 





 

Wall Temperature   CspeedTcilindru deg28040045.0200   

Head Calibration Factor    1 

Liner 

Surface Area    
2

2

610135.04500
4

mml
D

S pistonsegment 





 

Wall Temperature TDC  CspeedT PMSsegment deg24080045.0200_   

Wall Temperature BDC  CspeedT PMIsegment deg200120045.0200_   

Liner Calibration Factor    1 

Combustion System     DI (Direct Injection) 

In-cylinder Swirl Ratio    1 

 

 
Fig. 7.26 Opțiunea HEAT TRANSFER 
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Laborator 8: 

Modelarea și simularea unui motor po-

licilindric cu aprindere prin comprima-

re. Parametrizare elemente model. 

 

Scop 

 Crearea, parametrizarea și simularea unui model de motor cu aprindere prin 

comprimare policilindric. 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a unor metode moderne de investigare a pro-

ceselor funcționale ale motoarelor cu ardere internă; 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată. 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în modelarea unui motor cu aprindere prin comprimare policilindric. Se 

prezintă detaliat de parametrizare a fiecărui element component al modelului. 

 

Desfășurarea lucrării 

Lucrarea de laborator se desfășoară prin parcurgerea algoritmului prezentat în 

cele ce urmează, în scopul realizării unei aplicații practice de modelare a unui motor 

policilindric cu aprindere prin comprimare. Este o continuare a lucrărilor de laborator 

efectuate în cadrul ședinței numărul 7 și de aceea se va încărca modelul deja realizat 

prin accesul opțiunii File -> Open, din bara de mediu. Se continuă procesul de pa-

rametrizare a celorlalte elemente componente ale modelului. 
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Pas 5. Opțiunea VALVE PORT SPECIFICATIONS 

Click pe subgrupul Valve Port Specification și introduceți datele din figura 8.1: 

 

Pipe  Control  Surface Area (mm2)  Wall Temperature (degC) 

7  Valve   900     50 

11  Valve   700     500 

 

 
Fig. 8.1 Opțiunea VALVE PORT SPECIFICATIONS 

 

Click pe subgrupul VPS [1]: Pipe 7: Intake -> Valve Controlled pentru accesarea 

câmpurilor de introducere a datelor (figura 8.2): 

 

 
Fig. 8.2 Subgrupul Intake -> Valve Controlled 
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Inner Valve Seat 

(=Reference) Diameter    35 mm 

Valve Clearance     0.3 mm 

Scaling Factor 

for Eff. Flow Area  900.0
444

22

2

22

 ivi

i

ivi
sceff

dvndp

dp

dvndp
fA








  

unde α este coeficientul de curgere (Flow Coefficent) [-], dpi – diametrul con-

ductei considerate [m], nv este numărul de supape pentru portul considerat [-], dvi – 

diametrul scaunului interior al supapei (Inner Valve Seat Diameter) [m]. 

Click pe Lift Curve pentru fereastra de lucru și introduceți următoarele date: 

Specification      Manipulation   

Valve Opening  345 deg   Valve Opening  345 deg  

Cam Length  166 deg   Cam Length  166 deg 

Increment   1.1527 deg 

Datele necesare parametrizării procesului de admisie (definite pentru elementul 

Pipe 7 a diagramei distribuției la admisie Crank Angle și Valve Lift) sunt cele pre-

zentate în figura 8.3 și în tabelul 8.1, iar aceste date trebuie introduce în câmpurile 

respective. 

 

 
Fig. 8.3 Subgrupul Intake -> Intake Lift Curve 



103 

 

 

Tabelul 8.1 Valorile Intake Lift Curve 

Crank An-
gle X (deg) 

Valve Lift Y 
(mm) 

Crank An-
gle X (deg) 

Valve Lift Y 
(mm) 

Crank An-
gle X (deg) 

Valve Lift Y 
(mm) 

345 0.000000 400 6.015060 456 6.015060 

346 0.000020 402 6.176650 457 5.846990 

347 0.000639 403 6.331710 458 5.672500 

348 0.003795 404 6.480180 459 5.491670 

350 0.010796 405 6.622010 460 5.304560 

351 0.021796 406 6.757140 461 5.111250 

352 0.036796 407 6.885540 463 4.911810 

353 0.055773 408 7.007150 464 4.706330 

354 0.078156 410 7.121950 465 4.494880 

355 0.102000 411 7.229900 466 4.277560 

357 0.125998 412 7.330970 467 4.054450 

358 0.149998 413 7.425140 468 3.825640 

359 0.173998 414 7.512380 470 3.591240 

360 0.197998 415 7.592670 471 3.351340 

361 0.221997 416 7.665990 472 3.106050 

362 0.241200 418 7.732350 473 2.855470 

363 0.269997 419 7.791720 474 2.599700 

365 0.293997 420 7.844110 475 2.338870 

366 0.317997 421 7.889510 476 2.073070 

367 0.341996 422 7.927930 478 1.802440 

368 0.366205 423 7.959370 479 1.528250 

369 0.395920 425 7.983810 480 1.262510 

370 0.449106 426 8.001280 481 1.026120 

372 0.537866 427 8.011750 482 0.826366 

373 0.663616 428 8.015250 483 0.663616 

374 0.826366 429 8.011750 485 0.537866 

375 1.026120 430 8.001280 486 0.449106 

376 1.262510 431 7.983810 487 0.395920 

377 1.528250 433 7.959370 488 0.366205 

378 1.802440 434 7.927930 489 0.341996 

380 2.073070 435 7.889510 490 0.317997 

381 2.338870 436 7.844110 491 0.293997 

382 2.599700 437 7.791720 493 0.269997 

383 2.855470 438 7.732350 494 0.245997 

384 3.106050 440 7.665990 495 0.221997 

385 3.351340 441 7.592670 496 0.197998 

387 3.591240 442 7.512380 497 0.173998 

388 3.825640 443 7.425140 498 0.149998 

389 4.054450 444 7.330970 500 0.125998 

390 4.277560 445 7.229900 501 0.102000 

391 4.494880 446 7.121950 502 0.078156 

392 4.706330 448 7.007150 503 0.055773 

393 4.911810 449 6.885540 504 0.036796 

395 5.111250 450 6.757140 505 0.021796 

396 5.304560 451 6.622010 506 0.010796 

397 5.491670 452 6.480180 508 0.037950 

398 5.672500 453 6.331710 509 0.000639 

399 5.846990 455 6.176650 510 0.000000 
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Click on Flow Coefficient pentru deschiderea ferestrei de lucru și introduceți 

următoarele valori (tabelul 8.2 și figura 8.4): 

 

Tabelul 8.2 Valorile Flow Coefficient 

Valve Lift X  
(mm) 

Flow Coefficient Y  
(-) 

0 0.00 

1 0.15 

2 0.25 

3 0.33 

4 0.40 

5 0.45 

6 0.50 

7 0.53 

8 0.54 

9 0.54 

10 0.55 

  

Pressure Ratio:    1 

Effective Valve Lift:   Activated 

 

 
Fig. 8.4 Subgrupul Intake -> Flow Coefficient 

 

Click pe subgrupul VPS [2]: Pipe 11 Exhaust -> Valve Controlled pentru ac-

cesarea câmpurilor de introducere a datelor (figura 8.5): 
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Fig. 8.5 Subgrupul Exhaust -> Valve Controlled 

 

Inner Valve Seat  

(=Reference) Diameter    30 mm 

Valve Clearance     0.3 mm 

Scaling Factor 

for Eff. Flow Area  95.0
444

22

2

22

 ivi

i

ivi
sceff

dvndp

dp

dvndp
fA








  

unde α este coeficientul de curgere (Flow Coefficent) [-], dpi – diametrul con-

ductei considerate [m], nv este numărul de supape pentru portul considerat [-], dvi – 

diametrul scaunului interior al supapei (Inner Valve Seat Diameter) [m]. 

Click pe Lift Curve pentru deschiderea ferestrei de lucru și introduceți urmă-

toarele date: 

Specification 

Valve Opening      196 deg 

Cam Length      180 deg 

Manipulation 

Valve Opening      196 deg 

Cam Length      180 deg 

Increment       1.1538 deg 

Datele necesare parametrizării procesului de admisie (definite pentru elementul 

Pipe 15 a diagramei distribuției la evacuare Crank Angle și Valve Lift) sunt cele 

prezentate în tabelul 8.3 și în figura 8.6, iar aceste date trebuie introduce în câmpuri-

le respective. 
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Tabelul 8.3 Valorile Exhaust Lift Curve 

Crank An-

gle X (deg) 

Valve Lift Y 

(mm) 

Crank An-

gle X (deg) 

Valve Lift Y 

(mm) 

Crank An-

gle X (deg) 

Valve Lift Y 

(mm) 

196 0.000000 254 5.843630 312 6.885250 

199 0.000385 255 6.033150 313 6.727840 

200 0.002875 256 6.216420 314 6.563850 

201 0.009077 257 6.393350 315 6.393350 

202 0.019277 259 6.563850 316 6.216420 

203 0.033477 260 6.727840 317 6.033150 

204 0.051668 261 6.885250 318 5.843630 

205 0.073492 262 7.036010 320 5.647950 

207 0.097205 263 7.180060 321 5.446200 

208 0.121200 264 7.317330 322 5.238500 

209 0.145200 265 7.447780 323 5.024940 

210 0.169200 267 7.571340 324 4.805640 

211 0.193200 268 7.687990 325 4.580710 

212 0.217200 269 7.797670 327 4.350270 

214 0.241200 270 7.900350 328 4.114460 

215 0.265200 271 7.996010 329 3.873380 

216 0.289200 272 8.084620 330 3.627190 

217 0.313200 274 8.166160 331 3.376010 

218 0.337200 275 8.240630 332 3.119970 

219 0.361200 276 8.308000 333 2.859230 

220 0.385200 277 8.368280 335 2.593940 

222 0.409200 278 8.421470 336 2.324230 

223 0.433200 279 8.467570 337 2.050270 

224 0.457212 280 8.506580 338 1.772430 

225 0.482666 282 8.538490 339 1.496720 

226 0.521624 283 8.563320 340 1.243060 

227 0.592070 284 8.581050 342 1.024820 

229 0.699620 286 8.595230 343 0.843571 

230 0.843571 287 8.591690 344 0.699320 

231 1.024820 289 8.581050 345 0.592070 

232 1.243060 290 8.563320 347 0.482666 

233 1.496720 291 8.538490 348 0.457212 

234 1.772430 292 8.506580 350 0.433200 

235 2.050270 293 8.467570 351 0.409200 

237 2.324230 294 8.421470 352 0.385200 

238 2.593940 295 8.368280 353 0.361200 

239 2.859230 297 8.308000 354 0.337200 

240 3.119970 298 8.240630 355 0.313200 

241 3.376010 299 8.166160 357 0.289200 

242 3.627190 300 8.084620 358 0.265200 

244 3.873380 301 7.996010 359 0.241200 

245 4.114460 302 7.900350 360 0.217200 

246 4.350270 304 7.797670 361 0.193200 

247 4.580710 305 7.687990 362 0.169200 

248 4.805630 306 7.571340 363 0.145200 

249 5.024940 307 7.447780 365 0.121200 

250 5.238500 308 7.317330 367 0.073492 

252 5.446200 309 7.180060 369 0.033477 

253 5.647950 310 7.036010 370 0.000000 
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Fig. 8.6 Subgrupul Exhaust -> Exhaust Lift Curve 

  

Click on Flow Coefficient pentru deschiderea ferestrei de lucru și introduceți 

următoarele valori (tabelul 8.4 și figura 8.7): 

 

Tabelul 8.4 Valorile Flow Coefficient 

Valve Lift X  
(mm) 

Flow Coefficient Y  
(-) 

0 0.00 

1 0.17 

2 0.27 

3 0.34 

4 0.39 

5 0.43 

6 0.47 

7 0.50 

8 0.52 

9 0.53 

10 0.00 

  

Pressure Ratio:      1 

Effective Valve Lift:     Activated 

 



108 

 

 
Fig. 8.7 Subgrupul Exhaust -> Flow Coefficient 

 

AIR CLEANER 

Accesul la câmpurile necesare parametrizării elementului filtru de aer (Air 

Cleaner) din cadrul modelului general se efectuează prin efectuarea unui click pe 

element. Se accesează opțiunile din meniu și se introduc datele prezentate în cele ce 

urmează. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 8.8 și figura 

8.9): 

 

Geometrical Properties 

Total Air Cleaner Volume    1.0 l 

Inlet Collector Volume    0.3 l 

Outlet Collector Volume    0.3 l 

Length of Filter Element    350 mm 

Friction Specification     Coefficient 

Coefficient 

Friction Coefficient     0.02 

Laminar Friction Coefficient   64 
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Pas 2. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients introduceți următoarele valori (figura 

8.10): 

 

 
Fig. 8.8 Opțiunea GENERAL 

 

 
Fig. 8.9 Opțiunea FRICTION 

 

 
Fig. 8.10 Opțiunea FLOW COEFFICIENTS 
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Pipe 1  Inflow 0.98   Pipe 2   Inflow 0.98 

   Outflow 0.98      Outflow 0.98 

 

CATALYST 

Accesul la câmpurile necesare parametrizării elementului catalizator (Catalyst) 

din cadrul modelului general se efectuează prin efectuarea unui click pe element. Se 

accesează opțiunile din meniu și se introduc datele prezentate în cele ce urmează. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 8.11): 

 

  
Fig. 8.11 Opțiunea GENERAL 

 

Chemical Reactions     none 

Monolith Volume     3.2 l 

Length of Monolith     300 mm 

Inlet Collector Volume    0.15 l 

Outlet Collector Volume    0.15 l 

 

Pas 2. Opțiunea TYPE SPECIFICATION 

Click pe subgrupul Type Specification și introduceți valorile (figura 8.12): 

Catalyst Type Specification 

General Catalyst 

Open Frontal Area (OFA)    1 
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Hydraulic Unit 

Diameter       117 mm 

Geometrical Surface Area    34.188034 

 

  
Fig. 8.12 Opțiunea TYPE SPECIFICATION 

 

Pas 3. Opțiunea FRICTION 

Click pe subgrupul Friction și introduceți următoarele valori (figura 8.13): 

 

  
Fig. 8.13 Opțiunea FRICTION 
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Friction Specification     Coefficient 

Coefficient 

Coefficient a      64 

Coefficient b      -1 

Turbulent       0.019 

 

Pas 4. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients  și introduceți următoarele valori: 

Pipe 4  Inflow     0.98 

Pipe 4  Outflow     0.98 

Pipe 32  Inflow     0.98 

Pipe 32  Outflow     0.98 

 

SYSTEM BOUNDARY 

Prin accesarea acestui câmp de parametrizare se vor defini “granițele” modelu-

lui: zona de admisie și zona de evacuare. Accesul la fiecare zonă se realizează 

printr-un click pe elementul din cadrul modelului necesar a fi parametrizat. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General ->Standard -> Boundary Type (figura 8.14). 

 

  
Fig. 8.14 Opțiunea GENERAL 

 

Pas 2. Opțiunea BOUNDARY CONDITIONS 

Click pe subgrupul Boundary Conditions și introduceți valorile din tabelul 8.5: 
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Tabel 8.5 Condițiile de inițializare 

Set Pressure 

(bar) 

Temperature 

(degC) 

Fuel Va-

pour (-) 

Combustion 

Products (-) 

A/F Ratio 

(-) 

SB 1 0.969 20 0 0.0 14.57 

SB 2 0.970 40 0 0.2 14.57 

 
 

Selectați Local Boundary -> Conditons și Set 1 din meniul Preference (figura 

8.15): 

 

  
Fig. 8.15 Opțiunea BOUNDARY CONDITIONS 

 

Pas 3. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

SB 1 

Pipe 23 

  Inflow     0.95 

  Outflow     0.90 

SB 2 

Pipe 24 

  Inflow     0.95 

  Outflow     0.90 

 

PLENUM 

Prin accesarea acestui câmp de parametrizare se vor defini volumele de com-

pensare ale modelului (Plenum). Accesul la fiecare volum se realizează printr-un 

click pe elementul din cadrul modelului, necesar a fi parametrizat. 
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Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți valorile de mai jos pentru parametrul 

Volume corespunzători pentru elementele Plenum din model (figura 8.16): 

Plenum 1    Volum  5 l 

Plenum 2    Volum  2 l 

Plenum 3    Volum  4 l 

 

  
Fig. 8.16 Opțiunea GENERAL 

 

Pas 2. Opțiunea INITIALIZATION 

Click pe subgrupul Initialization și selectați Global Initialization pentru fiecare 

Plenum din model. Selectați opțiunea Set x din meniul Preference (figura 8.17): 

 

Plenum 1    Set 4 

Pressure 0.986 bar  Temperature 70 degC  A/F Ratio 14.57 

Plenum 2    Set 5 

Pressure 1.000 bar  Temperature 280 degC  A/F Ratio 14.57 

Plenum 3    Set 9 

Pressure 0.975 bar  Temperature 200 degC  A/F Ratio 14.57 
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Fig. 8.17 Opțiunea INITIALIZATION 

 

Pas 3. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

 

Plenum 1 

 Pipe 1   Inflow 0.95  Outflow  0.90 

 Pipe 9   Inflow 0.95  Outflow  0.90 

 Pipe 12   Inflow 0.95  Outflow  0.90 

 

Plenum 2 

 Pipe 20   Inflow 0.95  Outflow  0.90 

 Pipe 22   Inflow 0.95  Outflow  0.90 

 Pipe 25   Inflow 0.95  Outflow  0.90 

Plenum 3 

 Pipe 3   Inflow 0.95  Outflow  0.90 

 Pipe 24   Inflow 0.95  Outflow  0.90 

 
Restrictions 

Dublu-Click pe grupul Restrictions și selectați subgrupurile următoare: 

Pas 1. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients și introduceți următoarele valori: 

Restriction 1 

 from Pipe 4 to Pipe 5    0.95 

 from Pipe 5 to Pipe 4    0.95 

Restriction 2 

 from Pipe 15 to Pipe 17   0.95 

 from Pipe 17 to Pipe 15   0.95 
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Restriction 3 

 from Pipe 16 to Pipe 18   0.95 

 from Pipe 18 to Pipe 16   0.95 

Restriction 4 

 from Pipe 19 to Pipe 20   0.95 

 from Pipe 20 to Pipe 19   0.95 

Restriction 5 

 from Pipe 25 to Pipe 26   0.25 

 from Pipe 26 to Pipe 25   0.25 

 

JUNCTION 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General pentru deschiderea ferestrei de lucru (figura 8.18). 

Alegeți pentru fiecare joncțiune din model unul tipurile constructive de mai jos: 

Junction 1       Constant Pressure 

Junction 2       Refined Model 

Junction 3       Refined Model 

Junction 4       Refined Model 

Junction 5       Refined Model 

 

  
Fig. 8.18 Opțiunea GENERAL 

 

Pas 2. Opțiunea Constant Pressure / Refined Model 

Click pe subgrupul Constant Pressure (figura 8.19), sau Refined Model (figu-

ra 8.20) în funcție de tipul de joncțiune care urmează a fi definit. Introduceți datele de 

mai jos pentru fiecare joncțiune din model: 
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Fig. 8.19 Subgrupul Constant Pressure 

 

Junction 1       Constant Pressure 

Pipe 5 Inflow  0.95    Pipe 5 Outflow  0.90 

Pipe 6 Inflow  0.95    Pipe 6 Outflow  0.90 

Pipe 7 Inflow  0.95    Pipe 7 Outflow  0.90 

Pipe 10 Inflow  0.95    Pipe 10 Outflow  0.90 

 

  
Fig. 8.20 Subgrupul Refined Model 

 

Junction 2       Refined Model 

Angle Between Pipes   6 and 8 is    90 deg 

Angle Between Pipes   8 and 9 is  180 deg 

Angle Between Pipes   9 and 6 is    90 deg 

 

Junction 3       Refined Model 

Angle Between Pipes   11 and 12 is    30 deg 

Angle Between Pipes   12 and 15 is  165 deg 

Angle Between Pipes   15 and 11 is  165 deg 
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Junction 4       Refined Model 

Angle Between Pipes   13 and 14 is    30 deg 

Angle Between Pipes   14 and 16 is  165 deg 

Angle Between Pipes   16 and 13 is  165 deg 

 

Junction 5       Refined Model 

Angle Between Pipes   17 and 18 is    30 deg 

Angle Between Pipes   18 and 19 is  165 deg 

Angle Between Pipes   19 and 17 is  165 deg 

 

AIR COOLER 

Accesul la câmpurile necesare parametrizării elementului răcitor (Air Cooler) 

din cadrul modelului general se efectuează prin efectuarea unui click pe element. Se 

accesează opțiunile din meniu și se introduc datele prezentate în cele ce urmează. 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 8.21): 

 

  
Fig. 8.21 Opțiunea GENERAL 

 

Geometrical Properties   CO 1    CO 2 

Total Air Cooler Volume   2.0 l    0.4 l 

Inlet Collector Volume   0.5 l    0.1 l 

Outlet Collector Volume   0.5 l    0.1 l 

Length of Cooling Core   200 mm   150 mm 

Hydraulic Setting    none    none 
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Pas 2. Opțiunea REFERENCE OPERATING CONDITIONS 

Click pe subgrupul Reference Operating Conditions și introduceți următoare-

le valori (figura 8.22): 

       CO 1    CO 2 

Friction Specification    Coefficient   Target Pressure Drop 

Heat Transfer Specification  Target Outlet  Target Outlet 

Reference Operating Conditions 

Mass Flow      0.35 kg/s   0.04 kg/s 

Inlet Air Temperature    80 degC   350 degC 

       CO 1    CO 2 

Inlet Pressure     1.0 bar   2.8 bar 

Friction 

Friction Coefficient    0.02    - 

Target Pressure Drop   -    0.05 bar 

Laminar Friction Coefficient  64    - 

Heat Transfer 

Coolant Temperature    25 degC   65 degC 

Target Outlet Temperature   69 degC   80 degC 

 

  
Fig. 8.22 Opțiunea REFERENCE OPERATING CONDITIONS 
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Pas 3. Opțiunea FLOW COEFFICIENTS 

Click pe subgrupul Flow Coefficients  și introduceți următoarele valori: 

CO 1       Inflow   Outflow 

Pipe 1       0.95    0.90 

Pipe 21       0.95    0.90 

 

CO 1       Inflow   Outflow 

Pipe 26       0.95    0.90 

Pipe 27       0.95    0.90 

 

TURBOCHARGER 

Accesul la câmpurile necesare parametrizării elementului turbocompresor 

(Turbocharger) din cadrul modelului general se efectuează prin efectuarea unui 

click pe element. Se accesează opțiunile din meniu și se introduc datele prezentate 

în cele ce urmează. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și selectați opțiunea Simplified Model (figura 

8.23): 

 

  
Fig. 8.23 Opțiunea GENERAL 

 

Pas 2. Opțiunea SIMPLIFIED MODEL 

Click pe subgrupul Simplified Model și introduceți următoarele valori pentru 

subgrupul Compressor (figura 8.24), respectiv pentru subgrupul Turbine (figura 

8.25): 
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Fig. 8.24 Opțiunea SIMPLIFIED MODEL – COMPRESSOR 

 

Calculation Mode     Boost Pressure Calculation 

Compressor 

Corrected Volume Flow    (m3/s) 

Pressure Ratio      2 

Compressor Efficiency    0.7  

Reference Conditions 

Pressure       1 bar 

Temperature      25 degC 

 

Turbine 

Flow Type       Discharge Coefficient 

Equiv. Turbine Discharge Coeff.   0.1 

Pipe Area Scalling Factor    1 

Turbine Size Multiplier    1 

Turbocharger Overall Efficiency   0.5 

Mechanical Efficiency    0.98 
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Fig. 8.25 Opțiunea SIMPLIFIED MODEL – TURBINE 

 

 În subgrupul Pipe Attachments, conexiunile la conductele de legătură la intra-

rea și ieșirea din compresor, respectiv la intrarea și ieșirea din turbină sunt generate 

automat de către program așa cum este prezentat în figura 8.26. 

 

 
Fig. 8.26 Opțiunea PIPE ATTACHMENTS 
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Laborator 9: 

Modelarea și simularea unui motor po-

licilindric cu aprindere prin comprima-

re. Parametrizare hărți ECU. 

 

Scop 

 Crearea, parametrizarea și simularea unui model de motor cu aprindere prin 

comprimare policilindric. 

 

Obiective educaționale și de formare a competențelor 

 Formarea abilităților de utilizare a unor metode moderne de investigare a pro-

ceselor funcționale ale motoarelor cu ardere internă; 

 Însușirea de competențe avansate în procesele de modelare și simulare com-

puterizată. 

 

Prezentarea lucrării 

Lucrarea prezintă algoritmul de utilizare a programului de modelare și simulare 

AVL BOOST în modelarea unui motor cu aprindere prin comprimare policilindric. Se 

prezintă detaliat modul de parametrizare a elementului de comandă și control (ECU) 

al modelului. De asemenea procesul de parametrizare a motorului policilindric fiind 

finalizat este prezentat și procesul de simulare și afișare a rezultatelor. 

 

Desfășurarea lucrării 

Lucrarea de laborator se desfășoară prin parcurgerea algoritmului prezentat în 

cele ce urmează, în scopul realizării unei aplicații practice de modelare a unui motor 

policilindric cu aprindere prin comprimare, fiind o continuare a lucrărilor de laborator 

cu numărul 7 și 8.  
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Se încărca modelul deja realizat prin accesul opțiunii File -> Open, din bara de 

mediu, și se continuă procesul de parametrizare a modelului. 

 

PIPES 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General pentru deschiderea ferestrei de lucru (figura 9.1). 

Pentru fiecare conductă din cadrul modelului introduceți datele din tabelul 9.1. Valoa-

rea inițială de (100000 mm) este utilizată pentru caracterizarea parametrului general 

Bending Radius. În subgrupul Initialization, selectați Global set din meniul Prefe-

rence și selectați seturile de inițializare specificate în tabelul 7.1 (figura 9.2). 

 

  
Fig. 9.1 Opțiunea GENERAL 

 

  
Fig. 9.2 Opțiunea INITIALIZATION 
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Tabel 9.1 Caracteristicile elementelor Pipes 

Pipe No. Pipe Len-

gth (mm) 

Diameter  

(mm) 

Friction 

Coeff (-) 

Wall Temp 

(degC) 

Global Inititia-

lization 

Pipe 1 1000 50 0.038 69 Set 4 global 

Pipe 2 1000 TABLE 1* 0.020 34 Set 2 global 

Pipe 3 500 TABLE 2* 0.020 226.7 Set 8 global 

Pipe 4 40 70 0.034 69 Set 4 global 

Pipe 5 100 70 0.034 69 Set 4 global 

Pipe 6 100 70 0.020 69 Set 4 global 

Pipe 7 300 30 0.036 69 Set 4 global 

Pipe 8 300 30 0.036 69 Set 4 global 

Pipe 9 300 30 0.036 69 Set 4 global 

Pipe 10 300 30 0.036 69 Set 4 global 

Pipe 11 60 34 0.040 280 Set 5 global 

Pipe 12 60 34 0.040 280 Set 5 global 

Pipe 13 60 34 0.040 280 Set 5 global 

Pipe 14 60 34 0.040 280 Set 5 global 

Pipe 15 50 35 0.023 280 Set 5 global 

Pipe 16 50 35 0.023 280 Set 5 global 

Pipe 17 350 50 0.023 280 Set 5 global 

Pipe 18 350 50 0.023 280 Set 5 global 

Pipe 19 50 50 0.020 280 Set 5 global 

Pipe 20 50 50 0.021 280 Set 5 global 

Pipe 21 1000 TABLE 3* 0.038 80 Set 3 global 

Pipe 22 500 100 0.038 22 Set 1 global 

Pipe 23 500 100 0.038 280 Set 5 global 

Pipe 24 1000 50 0.038 40 Set 10 global 

Pipe 25 150 20 0.035 280 Set 5 global 

Pipe 26 100 20 0.035 280 Set 5 global 

Pipe 27 150 22 0.035 80 Set 6 global 

Pipe 28 150 50 0.020 252 Set 7 global 

 

 

Tabel 9.2 Caracteristicile geometrice ale elementelor Pipes 

Nr. TABLE 1 TABLE 2 TABLE 3 

 X [mm] Y [mm] X [mm] Y [mm] X [mm] Y [mm] 

1 0 250 0 50 0 50 

2 50 250 250 100 500 50 

3 350 200 500 100 750 100 

4 800 200 - - 1000 100 

5 1000 175 - - - - 
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Deoarece conductele 2, 3 și 21 sunt atribuite elementelor: turbocompresor, ca-

talizator și respectiv răcitor, acestea nu au un diametru constant pe toată lungimea 

lor (vezi forma constructivă a elementelor specificate) și de aceea trebuie definite cu 

ajutorul funcțiilor de parametrizare tabelare (tabelul 9.2).  

Pentru aceasta se face click pe simbolul , iar la deschiderea sub meniului se 

selectează opțiunea Table (figura 9.3). Pentru activarea câmpurilor de introducere a 

datelor de mai jos se selectează opțiunea Insert Row. 

 

  
Fig. 9.3 Opțiunea GENERAL – selectarea opțiunii Table 

 

MEASURING POINT 

Introducerea punctelor de măsurare și monitorizare în cadrul unui model apare 

ca și o necesitate în achiziția unor parametrii specifici, pentru analiza suplimentară a 

acestora (pe lângă valorile reieșite din simularea modelului). În cazul de față ne inte-

resează care este variația coeficientului de umplere (sau randamentul volumetric) în 

cadrul unui ciclu funcțional al motorului cu aprindere prin scânteie studiat. 

 

Pas 1. Opțiunea GENERAL 

Click pe subgrupul General și introduceți următoarele valori (figura 9.4 și tabe-

lul 9.3): 
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Fig. 9.4 Opțiunea GENERAL 

 

Tabel 9.3 Amplasarea punctelor de măsurare 

Measuring Point Location of Measuring Point 

from Upstream Pipe End (mm) 

Output Extension 

Measuring Point 1 100 Extended 

Measuring Point 2 100 Extended 

Measuring Point 3 50 Extended 

Measuring Point 4 50 Extended 

Measuring Point 5 100 Extended 

Measuring Point 6 100 Extended 

Measuring Point 7 50 Extended 

Measuring Point 8 50 Extended 

Measuring Point 9 100 Extended 

Measuring Point 10 100 Extended 

Measuring Point 11 50 Extended 

Measuring Point 12 100 Extended 

 

Reference Point for Volumetric Efficiency 

Selectați opțiunile Simulation -> Volumetric Efficiency pentru deschiderea fe-

restrei de lucru. Selectați Measuring Point 2 ca și element de referință (figura 9.5). 

 

  
Fig. 9.5 Opțiunea Volumetric Efficiency 
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ECU 

Pas 1. Opțiunea GENERAL 

Dublu click pe elementul ECU pentru editare (figura 9.6). Click pe opțiunea 

General și introduceți valorile de mai jos: 

Desired Engine Speed    2500 rpm 

Speed Control Gains 

Proportional      0.01 1/rpm 

Integral       0.001 1/rpm/s 

Differential      0 s/rpm 

Load Signal Base Value    0 

Dynamic Functions Activated for 

Positive load changes greater than  1 1/s 

Negative load changes smaller than  1 1/s 

Frecquency Control     Cyclic 

 

 

Fig. 9.6 Opțiunea GENERAL 

 

Pas 2. Opțiunea MAP SPECIFICATION 

Click pe opțiunea Map Specification. Inserați în rândurile tabelului elementele 

controlate și comandate de ECU (figura 9.7). Faceți click pe butonul de acces la me-

niu și alegeți parametrul de definește fiecare element controlat și comandat de ECU 

elementul (opțiunea necesară). Pentru Cylinder 1 … 4: Fuelling - masa de combus-

tibil injectată, Start of Injection – respectiv momentul de început al injecției. 
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Element       Actuator Channel 

Cylinder 1 … 4      Fuelling 

Cylinder 1 … 4      Start of Injection 

 

 

Fig. 9.7 Opțiunea MAP SPECIFICATION 

  

Pas 3. Engine Control Unit - Maps Flow Chart 

Click pe opțiunea Maps Flow Chart. Se va deschide ecranul în care este pre-

zentat modul de compunere și funcționare a ECU pe baza hărților specifice procese-

lor funcționale ale motorului (figura 9.8). 

 

 

Fig. 9.8 Opțiunea ENGINE CONTROL UNIT – MAPS FLOW CHART 
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Pas 4. C1 – Fuelling 

Click pe opțiunea C1 – Fuelling. Selectați pentru meniul Baseline Value opți-

unea Map pentru parametrul C1 – Fuelling (figura 9.9). 

 

 

Fig. 9.9 Opțiunea C1 – FUELLING 

 

Pas 5. C1 – Fuelling Baseline Map  

Click pe opțiunea Baseline Map. Introduceți datele din figura 9.10: 

Speed       2500 rpm 

Load Signal      1 

Fuelling       4.00 mg 

 

 

Fig. 9.10 Opțiunea C1 – FUELLING BASELINE MAP 
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Click pe opțiunea Maximum Map și introduceți datele din figura 9.11: 

Speed       2500 rpm 

Load Signal      1 

Fuelling       4.50 mg 

 

 

Fig. 9.11 Opțiunea C1 – FUELLING MAXIMUM MAP 

 

Click pe opțiunea Minimum Map și introduceți datele din figura 9.12: 

Speed       2500 rpm 

Load Signal      1 

Fuelling       3.50 mg 

 

 

Fig. 9.12 Opțiunea FUELLING MINIMUM MAP 
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Definiți în mod identic opțiunea Fuelling pentru cilindrii C2, C3 și C4 pentru 

hărțile de injecție de bază, de corecție maximă și respectiv de corecție minimă. 

 

Pas 6. C1 – Start of Injection 

Click pe opțiunea C1 – Start of Injection. Selectați pentru meniul Baseline 

Value opțiunea Map pentru parametrul C1 – Start of Injection (figura 9.13). 

 

 

Fig. 9.13 Opțiunea C1 – START OF INJECTION 

 

Click pe opțiunea Baseline Map. Introduceți datele din figura 9.14: 

Speed       2500 rpm 

Load Signal      1 

Start of Injection     - 5.50 deg 

 

 

Fig. 9.14 Opțiunea C1 – START OF INJECTION BASELINE MAP 
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Click pe opțiunea Maximum Map. Introduceți datele din figura 9.15: 

Speed       2500 rpm 

Load Signal      1 

Start of Injection     - 6.00 deg 

 

 

Fig. 9.15 Opțiunea C1 – START OF INJECTION MAXIMUM MAP 

 

Click pe opțiunea Minimum Map. Introduceți datele din figura 9.16: 

Speed       2500 rpm 

Load Signal      1 

Start of Injection     - 5.00 deg 

 

 

Fig. 9.16 Opțiunea C1 – START OF INJECTION MINIMUM MAP 
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Definiți în mod identic opțiunea Start of Injection pentru cilindrii C2, C3, res-

pectiv C4 pentru hărțile de injecție de bază, de corecție maximă și respectiv de co-

recție minimă. 

 

Atenție !!! Nu uitați să apăsați butonul Apply pentru ca datele deja introduse (și 

setările astfel realizate) să fie salvate ! Înainte de a porni simularea salvați mo-

delul ! 

 

Run Simulation 

Selectați opțiunile Simulation -> Run din meniul de bază sau click pe butonul 

din bara de instrumente     pentru deschiderea ferestrei de lucru (figura 9.17). 

 

  
Fig. 9.17 Opțiunea RUN SIMULATION 

 

Cases: selectați toate cazul de simulare și porniți procesul de simulare (figura 

9.18). 

Tasks: selectați cazul de simulare care să conțină seturile de date necesare a 

fi analizate și rezultate în urma procesului de simulare. 

Pentru începerea efectivă a procesului de simulare click pe butonul Run, iar în 

fereastra ce se va deschide se poate urmări desfășurarea și informații suplimentare 

privind procesul de simulare (figura 9.19). 
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Fig. 9.18 Opțiunea RUN SIMULATION 

 

  
Fig. 9.19 Derularea procesului de simulare 

 

Odată cu finalizarea procesului de simulare faceți click pe butonul OK pentru 

ieșire din această fereastră de lucru, iar după aceea, alegeți opțiunea Close pentru 

ieșirea din fereastra de lucru Simulation Status (figura 9.20). 

 



136 

 

  
Fig. 9.20 Încheierea procesului de simulare 

 

Analiza rezultatelor (Impress Chart) 

Analiza rezultatelor obținute se va efectua cu ajutorul programului de post-

procesare Impress Chart. Din meniul Simulation – Show Results (figura 9.21) în-

cărcăm rezultatele simulărilor în Impress Chart (figura 9.22). 

 

  
Fig. 9.21 Meniul Simulation – Show Results 
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Fig. 9.22 Programul post-procesare Impress Chart 

 

Rezultatele simulărilor computerizate se aleg din cele două baze de rezultate: 

 Transients: rezultate ale simulărilor raportate la timp (s) pe abscisa graficului 

 Traces: rezultate ale simulărilor raportate la unghiul de rotație al arborelui cotit 

(deg) 

și se transpun pe grafic (Layer) cu dublu click pe parametrul care se dorește 

analizat: Pressure figura 9.23, Rate of Heat Release figura 9.24, NOx Accumulated 

figura 9.25, respectiv Soot Accumulated figura 9.26. 

 

  
Fig. 9.23 Rezultatele simulărilor computerizate: Pressure 
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Fig. 9.24 Rezultatele simulărilor computerizate: Rate of Heat Release 

 

 

  
Fig. 9.25 Rezultatele simulărilor computerizate: NOx Accumulated 
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Fig. 9.26 Rezultatele simulărilor computerizate: Soot Accumulated 
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Teste de autoevaluare,  

teme și aplicații practice 

 

1. Modificați pentru diferite valori, parametrii ce caracterizează modelul de ardere 

Vibe, față de modelul creat în cadrul lucrărilor de laborator 2 – 4. Rulați simularea și 

comparați rezultatele. Explicați diferențele. 

 

2. Modificați în modelul de motor durata de deschidere a supapei de admisie (Cam 

Length) pentru valori cuprinse între 160 și 170 de grade. Realizați simulările aferente 

pentru un pas de 2 grade pentru fiecare caz. Afișați pe același grafic rezultatele obți-

nute și analizați influența variației acestui parametru asupra performanțelor motorului. 

 

3. Modificați în modelul de motor durata de deschidere a supapei de evacuare (Cam 

Length) pentru valori cuprinse între 175 și 185 de grade. Realizați simulările aferente 

pentru un pas de 2 grade pentru fiecare caz. Afișați pe același grafic rezultatele obți-

nute și analizați influența variației acestui parametru asupra performanțelor motorului. 

 

4. Pe baza rezultatelor obținute în cadrul testelor 2 și 3, analizați care proces (de ad-

misie sau de evacuare) prezintă o influență mai mare în eficiența energetică a unui 

motor cu ardere internă. 

 

5. Explicați lipsa elementului Injector în cadrul structurii modelului de motor cu aprin-

dere prin comprimare dezvoltat în cadrul lucrărilor de laborator. 

 

6. Care sunt modalitățile de reprezentare a datelor obținute prin simulare? 

 

7. Folosind rezultatelor obținute prin simularea modelului de motor realizat în cadrul 

laboratoarelor 7 – 9, afișați grafic parametrii Power și Torque în cadrul unui singur 

Layer, în zone diferite și cu scale de măsură diferite. 
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8. Folosind elementele de analiză statistică din utilitarul Impress Chart determinați 

valoarea totală, valoarea maximă și medie a Rate of Heat Release pentru modelul de 

motor cu aprindere prin comprimare din cadrul laboratoarelor 7 – 9. 

 

9. Creați un model de motor cu aprindere prin scânteie cu trei cilindrii în linie. 

 

10. Ce tipuri de conexiuni permite programul AVL BOOST să fie utilizate în construcția 

unui model? 

 

11. Modificați alternativ alezajul și cursa pistonului în exemplul prezentat în lucrările 

de laborator 2 – 4. Simulați noile modele și interpretați rezultatele comparativ cu mo-

delul inițial (din punct de vedere al performanțelor energetice ale motorului). 

 

12. Calculați aria efectivă de curgere prin orificiul unei supape pentru o supapă de 

admisie cu diametrul scaunului supapei de 40 mm și un coeficient α = 0.2 mm. 

 

13. Utilizați modelul din cadrul laboratoarelor 2 – 4 și modificați temperatura aerului 

admis la valoarea de 40 °C.  În urma analizei rezultatelor obținute prin simulare ce 

concluzii se pot trage? 

 

14. Analizați influența modificării tipului uleiului de ungere (pentru diferite clase de vis-

cozitate SAE) asupra performanțelor unui motor. 

 

15. Analizați influența modificării temperaturii uleiului de ungere asupra eficienței ener-

getice a unui motor. 

 

16. Folosind metodele de analiză numerică analizați influența modificării excentricității 

unui piston asupra performanțelor unui motor cu ardere internă. 

 

17. Explicați necesitatea/utilitatea introducerii în cadrul modelelor a unor puncte de 

referință (Measurement Points). 

 

18. Trasați diagrama indicată (coordonate p – V) pentru un model de motor realizat în 

cadrul activităților de laborator, prin utilizarea funcțiunilor specifice de setare a axelor 

de coordonate a Layer-ului de reprezentare grafică. 
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19. Pentru modelul de motor cu aprindere prin comprimare, modificați atât cantitatea 

injectată cât și durata pentru injecția pilot (alternativ). Realizați simularea computeri-

zată pentru 5 – 10 cazuri de lucru considerând variația doar unui singur parametru. Ce 

concluzii rezultă relativ la graficul Rate of Heat Release datorită procesului de ardere? 

 

20. Pentru modelul de motor cu aprindere prin comprimare, modificați legea de des-

chidere a acului injector (de exemplu: o lege de variație liniară). Realizați simularea și 

comparați datele obținute din punct de vedere al performanțelor funcționale ale moto-

rului. 

 

21. Reproduceți caracteristicile parametrilor de injecție determinați de legea de injecție 

iRate (calculated) prin legea de injecție NormROI (user defined), definind momen-

tele de început și sfârșit ale injecției pilot și injecției principale, respectiv durata acestor 

secvențe de injecție. 

 

22. Reprezentați în aplicația Impress Chart comparativ, rezultatele simulărilor obți-

nute pentru cele două legi de injecție (iRate și NormROI) pentru următoarele mărimi 

rezultate în urma procesului de ardere: Pressure, Temperature, VolumeWork, Rate 

of Heat Release, NOx Accumulated, respectiv Accumulated Soot. 

 

23. Optimizați parametrii de comandă ai ECU pentru legea de injecție iRate (delay_tu, 

delay_ts, delay_te, delay_td) în modelul motorului policilindric construit în laboratoa-

rele 7 – 9, astfel încât să rezulte valori similare pentru graficul Rate of Heat Release 

în aplicația Impress Chart în cazul utilizării celor două legi de injecție. 

 

24. Pentru modelul motorului policilindric construit în laboratoarele 7 – 9 introduceți o 

post-injecție care să înceapă la 2 °RAC după injecția principală și care să dureze 3 

°RAC. Repetați simulările și încărcați rezultatele în Impress Chart. 

 

25. Analizați graficul pentru Rate of Heat Release și NOx Accumulated pentru mo-

delul de motor cu două secvențe de injecție, respectiv cu trei secvențe de injecție. 

Comparați rezultatele obținute. 

 

26. Repetați simulările pe modelul de motor policilindric pentru diferite valori ale turației 

motorului (Speed) și ale cantității de combustibil injectată pe ciclu motor (Fuel Mass / 

Cycle), pornind de la valorile definite în model (2500 min-1 și 4 mg) și de la aceste 
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valori creșteți valoarea pentru cantitatea de combustibil injectată cu 1 mg pentru creș-

terea turației motorului cu 1000 min-1, respectiv reduceți valoarea pentru cantitatea de 

combustibil injectată cu 1 mg pentru scăderea turației motorului cu 1000 min-1. 

 

27. Pentru simulările realizate la subiectul 26, reprezentați în aplicația Impress Chart 

comparativ, rezultatele obținute pentru următoarele mărimi rezultate în urma procesu-

lui de ardere: Pressure, Temperature, VolumeWork, Rate of Heat Release, NOx 

Accumulated, respectiv Accumulated Soot. Fiecare dintre aceste mărimi vor fi re-

prezentate în câte un Layer pentru a evidenția evoluția parametrului evaluat odată cu 

modificarea turației motorului. 

 

28. Evaluați funcționarea modelului de motor policilindric la temperaturi de pornire scă-

zute: -10 °C, 0 °C, respectiv 10 °C, prin modificarea temperaturii ambientale în setul 

de condiții de inițializare (opțiunea Initialization), respectiv în zonele de parametrizare 

System Boundary (SB1, SB2) prin activarea opțiunii Local Boundary -> Conditons. 

 

29. Pentru simulările realizate la subiectul 28, reprezentați în aplicația Impress Chart 

comparativ, rezultatele obținute pentru următoarele mărimi rezultate în urma procesu-

lui de ardere: Pressure, Temperature, VolumeWork, Rate of Heat Release, NOx Ac-

cumulated, respectiv Accumulated Soot. 

 

30. Modificați tipul de combustibil definit în Simulation Control / Globals -> Classic 

Species Setup -> Fuel Properties pentru modelul de motor monocilindric. Repetați 

simulările încărcând fiecare tip de combustibil disponibil în secțiunea Fuel Properties. 

Evaluați rezultatele obținute prin analiza graficului pentru Rate of Heat Release. Evi-

dențiați și justificați cazurile în care motorul nu funcționează cu unele din tipurile de 

combustibil definite. 



145 

 

 

 

 

Bibliografie 

 

[1] AVL BOOST version 2014, 1 Cylinder Gasoline Engine Example, AVL List 

GmbH, Graz, Austria, Document no. 01.0103.2014.1, Edition 02.2015; 

[2] AVL BOOST version 2014, Aftertreatment, AVL List GmbH, Graz, Austria, Doc-

ument no. 01.0107.2014.1, Edition 02.2015; 

[3] AVL BOOST version 2014, Engine Performance Combustion Model Examples, 

AVL List GmbH, Graz, Austria, Document no. 01.0105.2014.1, Edition 02.2015; 

[4] AVL BOOST version 2014, Engine Performance Compression Ignited Exam-

ples, AVL List GmbH, Graz, Austria, Document no. 01.0105.2014.1, Edition 

02.2015;  

[5] AVL BOOST version 2011, Examples, AVL List GmbH, Graz, Austria, Docu-

ment no. 01.0105.2011, Edition 07.2011; 

[6] AVL BOOST version 2011, Gas Properties Tool Users Guide, AVL List GmbH, 

Graz, Austria, Document no. 01.0118.2011, Edition 07.2011; 

[7] AVL BOOST version 2011, Primer, AVL List GmbH, Graz, Austria, Document 

no. 01.0103.2011; 

[8] AVL BOOST version 2014, Theory, AVL List GmbH, Graz, Austria, Document 

no. 01.0114.2014.1, Edition 02.2015; 

[9] AVL BOOST version 2014, Users Guide, AVL List GmbH, Graz, Austria, Doc-

ument no. 01.0104.2014.1, Edition 02.2014; 

[10] AVL BOOST version 2014, Validation, AVL List GmbH, Graz, Austria, Doc-

ument no. 01.0106.2014.1, Edition 02.2014; 

[11] AVL WORKSPACE version 2011, Graphical User Interface Users Guide, 

AVL List GmbH, Graz, Austria, Document no. 18.0101.2011, Edition 07.2011; 

[12] AVL WORKSPACE version 2014, IMPRESS Chart Users Guide, AVL List 

GmbH, Graz, Austria, Document no. 18.0108.2014.1, Edition 02.2014. 

 

 


	APLICAȚII NUMERICE ÎN SIMULAREA PROCESELOR MOTOARELOR CU ARDERE INTERNĂ
	Prefață
	CUPRINS
	Laborator 1: Principiile modelării și simulării sistemelor de management ale motoarelor cu ardere internă. Prezentarea generală a programului AVL BOOST.
	Laborator 2: Modelarea și simularea unui motor monocilindric cu aprindere prin scân-teie. Setări generale.
	Laborator 3: Modelarea și simularea unui motor monocilindric cu aprindere prin scânteie. Parametrizarea motorului.
	Laborator 4: Modelarea și simularea unui motor monocilindric cu aprindere prin scânteie. Parametrizarea elementelor auxiliare.
	Laborator 5: Procesarea și analiza rezultatelor ob-ținute prin simulare
	Laborator 6: Implementarea elementelor de management, comandă și control (ECU) în modelele numerice
	Laborator 7: Modelarea și simularea unui motor policilindric cu aprindere prin comprimare. Construcție model și parametrizare generală motor.
	Laborator 8: Modelarea și simularea unui motor policilindric cu aprindere prin comprimare. Parametrizare elemente model.
	Laborator 9: Modelarea și simularea unui motor policilindric cu aprindere prin comprimare. Parametrizare hărți ECU.
	Teste de autoevaluare, teme și aplicații practice
	Bibliografie

